
TIBCO BusinessEvents®

WebStudio User's Guide
Software Release 5.6
August 2019



Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE)
OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER
LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

ANY SOFTWARE ITEM IDENTIFIED AS THIRD PARTY LIBRARY IS AVAILABLE UNDER
SEPARATE SOFTWARE LICENSE TERMS AND IS NOT PART OF A TIBCO PRODUCT. AS SUCH,
THESE SOFTWARE ITEMS ARE NOT COVERED BY THE TERMS OF YOUR AGREEMENT WITH
TIBCO, INCLUDING ANY TERMS CONCERNING SUPPORT, MAINTENANCE, WARRANTIES,
AND INDEMNITIES. DOWNLOAD AND USE OF THESE ITEMS IS SOLELY AT YOUR OWN
DISCRETION AND SUBJECT TO THE LICENSE TERMS APPLICABLE TO THEM. BY PROCEEDING
TO DOWNLOAD, INSTALL OR USE ANY OF THESE ITEMS, YOU ACKNOWLEDGE THE
FOREGOING DISTINCTIONS BETWEEN THESE ITEMS AND TIBCO PRODUCTS.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix, ActiveMatrix BusinessWorks, ActiveSpaces,
TIBCO Administrator, TIBCO BusinessEvents, TIBCO Designer, Enterprise Message Service, TERR,
TIBCO FTL, Hawk, TIBCO LiveView, TIBCO Runtime Agent, Rendezvous, and StreamBase are either
registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or other
countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. Please see the readme.txt file for
the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S)
AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.
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This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2004-2019. TIBCO Software Inc. All Rights Reserved.
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly
in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than any other
documentation included with the product. To access the latest documentation, visit https://
docs.tibco.com.

Product-Specific Documentation

Documentation for TIBCO products is not bundled with the software. Instead, it is available on the
TIBCO Documentation site. To directly access documentation for this product, double-click the
following file:

TIBCO_HOME/release_notes/TIB_businessevents-enterprise_5.6.0_docinfo.html where
TIBCO_HOME is the top-level directory in which TIBCO products are installed. On Windows, the
default TIBCO_HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME is /opt/tibco.

The following documents for this product can be found in the TIBCO Documentation site:

● TIBCO BusinessEvents Release Notes
● TIBCO BusinessEvents Installation
● TIBCO BusinessEvents Getting Started
● TIBCO BusinessEvents Architect's Guide
● TIBCO BusinessEvents Administration
● TIBCO BusinessEvents Developer's Guide
● TIBCO BusinessEvents Cloud Deployment Guide
● TIBCO BusinessEvents Data Modeling Developer's Guide
● TIBCO BusinessEvents Event Stream Processing Pattern Matcher Developer's Guide
● TIBCO BusinessEvents Event Stream Processing Query Developer's Guide
● TIBCO BusinessEvents Configuration Guide
● TIBCO BusinessEvents WebStudio User's Guide
● TIBCO BusinessEvents Decision Manager User's Guide
● Online References:

— TIBCO BusinessEvents Java API Reference
— TIBCO BusinessEvents Functions Reference

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:

● For an overview of TIBCO Support, visit http://www.tibco.com/services/support.
● For accessing the Support Knowledge Base and getting personalized content about products you are

interested in, visit the TIBCO Support portal at https://support.tibco.com.
● For creating a Support case, you must have a valid maintenance or support contract with TIBCO.

You also need a user name and password to log in to https://support.tibco.com. If you do not have a
user name, you can request one by clicking Register on the website.
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How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to 
https://community.tibco.com.
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TIBCO BusinessEvents WebStudio Concepts

The TIBCO BusinessEvents WebStudio along with the Rule Management Server (RMS) provides an
online tool to create and manage business rules and decision tables.

Rules Management Server (RMS)
Rules Management Server (RMS) is a server-based component that manages the repository of the
TIBCO BusinessEvents projects, lifecycle of the WebStudio artifacts and WebStudio user access.

RMS provides an easy, secure, and scripted deployment lifecycle. RMS is supported on all platforms
that support TIBCO BusinessEvents. Users can access RMS remotely. RMS does not have to be installed
on users’ machines.

Under certain circumstances, the use of RMS is optional. For details, see TIBCO BusinessEvents Decision
Manager User’s Guide.

You may require some basic configuration before you use RMS. You also set up the project resources
required for business users to create decision tables or business rules for each TIBCO BusinessEvents
project. See Configuring RMS Server Properties. Administrators can configure authentication and
access control as needed, see ACL Preferences.

RMS enables you to check out projects from the repository. The necessary project resources are loaded
into the cache and the artifacts are copied into the client’s machine. After you are finished working with
the projects, you check in the modified artifacts to RMS for approval. For more details about workflow,
see WebStudio and RMS User Workflow.

RMS is implemented using TIBCO BusinessEvents. Knowledgeable TIBCO BusinessEvents users can
customize it. The example projects are located in the BE_HOME/examples/standard/WebStudio
directory, you can configure the RMS to take projects from SVN location as well. Note that
documentation is provided for the product as it is shipped. If you customize RMS, some documentation
might not apply.

TIBCO BusinessEvents WebStudio Overview
As the TIBCO BusinessEvents WebStudio software is an online component, business users can create or
manage business rules in a web browser.

In the TIBCO BusinessEvents WebStudio software you can define an executable rule (business rule)
based on the rule template and the rule template view defined by the developer in TIBCO
BusinessEvents Studio. A decision table in TIBCO BusinessEvents WebStudio is defined using the
virtual rule function. RMS also supports lifecycle of domain model, where developers creates the
domain models in BusinessEvents Studio and can edit them in Studio as well as WebStudio. Rule
templates, rule template views, and virtual functions are created in TIBCO BusinessEvents Studio by
developers and are stored in the Rule Management Server (RMS) repositories.

Administrators can define access control settings and can approve or reject commit requests originating
from TIBCO BusinessEvents Studio and TIBCO BusinessEvents WebStudio users, check on the status of
all such requests, and keep track of all project versions. For more details, see Working with the Worklist
Items.

As an administrator you can also deploy decision tables or business rules when they are ready for use,
either in an enterprise archive (EAR) file, or as class files. You can deploy class files for use at startup, or
perform hot deployment. For more details, see Generating Deployable Files (EAR and Class Files).

The updates made to a decision table from TIBCO BusinessEvents Studio are visible in TIBCO
BusinessEvents WebStudio and vice-versa. If you have edited, saved, and committed a decision table in
TIBCO BusinessEvents Studio, the changes are displayed in the WebStudio as well in the worklist for
approval. Similarly, if you have edited, committed, and approved a decision table in WebStudio, the
changes are displayed in TIBCO BusinessEvents Studio after you synchronize the artifacts of the
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decision table. For details about synchronizing artifacts in TIBCO BusinessEvents Studio, see TIBCO
BusinessEvents Decision Manager User's Guide. In case of addition or deletion of a domain model or
decision table in TIBCO BusinessEvents Studio, commit the changes in TIBCO BusinessEvents Studio.
To see those changes in WebStudio, click the Refresh icon in the Group Contents section for the project.

For a better UI experience, the recommended screen resolution/scale and the browser zoom should be
at 100%.

RMS REST API

You can use RMS through a REST-based web service using the APIs provided with WebStudio. Using
these APIs you can perform complete WebStudio functionalities:

● for creating, modifying, or deleting artifacts (business rule, decision table)

● for lifecycle operations, such as, to check out, commit, or approve

● for worklist operations, such as, approval, rejection, or delegation of a worklist item

● for validating artifacts or analyzing decision tables.

After starting the RMS server, you can access API documentation, using the following URL:

http://<hostname>:<port>/WebStudio/apidoc

For example, the default URL to access the WebStudio API documentation is:

http://localhost:8090/WebStudio/apidoc/

Virtual Rule Functions and Decision Tables
In TIBCO BusinessEvents WebStudio, business users add decision table resources to VRFs. The decision
table provides the body to the VRF, also known as the VRF implementation.

In TIBCO BusinessEvents Studio, technical users add virtual rule functions (VRFs) to a TIBCO
BusinessEvents project. A VRF has no body, similar to a Java interface. Its implementation is provided
using decision tables authored in TIBCO BusinessEvents WebStudio. VRFs are used in the TIBCO
BusinessEvents project like any other rule function; they can be called from rules or other rule
functions.

For example:
/**
 * @description
 */
virtual void rulefunction Virtual_RF.Applicant_VirtualRuleFunction {
   attribute {
      validity = ACTION;
 }
   scope {
      Concepts.Applicant    applicant;
      Events.ApplicationReceived    applicationreceived;
   }
   body {
   }
}

One VRF can have more than one decision table. If a VRF has more than one decision table, functions in
TIBCO BusinessEvents determine how the tables are used.

Rule Building with Decision Tables
As a business user, you check out projects from RMS, build decision tables, and submit them for
approval in TIBCO BusinessEvents WebStudio.

Decision tables are available in TIBCO BusinessEvents WebStudio in the edit mode, only if you have
installed the Decision Manager component while installing the TIBCO BusinessEvents Enterprise
Edition.
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Decision tables provide a graphical way to build complex business rules. You create table columns by
dragging and dropping predefined properties onto the decision table editor. The properties belong to
ontology resources defined in the TIBCO BusinessEvents project. However, you can only use the
properties specified in the VRF. Columns can be created in other ways too. You then define threshold
values (conditions) and actions in the cells of the table. Each row can be thought of as one rule in a table
made up of many rules. The individual rules are often straightforward, as in the following examples.

Three Rule Conditions:
Person.age < Max(20, Parent.age)
Person.creditscore >= Math.function(...)
Person.gender == "female"

Three Rule Actions:
Application.status = "ACCEPTED"
Application.credit = 4000
sendNotification()

However, one decision table can consist of hundreds, even thousands of rules each of which is executed
only when its specific conditions are satisfied. In WebStudio a decision table could be displayed in
multiple pages to make them easily manageable.

Exception Tables

Each decision table can optionally have another table known as an exception table. The purpose of the
exception table is purely organizational: it enables you to separate the business logic of the main
decision table (added by business users) from any non-business logic (generally added by technical
users). For example, in the exception table, you could capture situations where fields are blank or
contain invalid values, and define actions that send notifications or set return values. The rows of a
decision table along with the rows of its exception table are considered in an RTC. If you prefer, you can
put non-business logic in the main table instead of using an exception table.

Table Analyzer

The Table Analyzer feature analyzes decision tables and reports problems, such as uncovered ranges
for conditions, uncovered domain entries, different set of actions for identical conditions.

Rule Template and Business Rule
A rule template is a specialized rule that contains a pre-conditions section which defines the pre-
conditions that must be met in addition to the conditions defined by the business user in a business
rule.

The Action Context section of a rule template defines all possible actions that can be taken by a business
rule (after all conditions are met). Only the action context statements that the WebStudio user selects
and defines as commands in the business rules are actually taken (depending on the rule evaluation at
runtime). For a business rule execution to succeed, a business rule definition must include all Actions
and the order should be maintained. Completing the definition of an action is a WebStudio user task. If
bindings are used (and a view) then in WebStudio, the business rule writer has to enter only the
binding values to complete the definition. Action context statements are of three types: create, modify,
and call, plus arbitrary actions.

Rule Building with Business Rules
As a business user, you check out projects from RMS, build business rules, and submit them for
approval in TIBCO BusinessEvents WebStudio.

Business rules provide builder or a user-friendly HTML form to build rules. In a builder you specify the
conditions in the “when” section and the actions in the “then” section. You can use artifacts and
supported operators for building conditions and actions. In the user-friendly HTML form, you fill up
the values for the conditions and actions.
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WebStudio and RMS User Workflow
The rules authored in TIBCO BusinessEvents WebStudio are made available to a TIBCO BusinessEvents
application after following a complete approval workflow.

Step 1: RMS Project Setup

A TIBCO BusinessEvents user creates a TIBCO BusinessEvents project, adding the ontology, and
writing rules that make use of virtual rule functions (VRFs) and Rule Templates.

The TIBCO BusinessEvents project for RMS is stored at the location defined by a property in the RMS
server configuration. The RMS project requires an access control file for authorization.

The RMS server must be running so that the login and workflow actions are available in the TIBCO
BusinessEvents WebStudio component.

Step 2: TIBCO BusinessEvents WebStudio

A business user starts the TIBCO BusinessEvents WebStudio component, logs on to RMS, and checks
out the project. The business user creates one or more decision tables, business rules, or process and
saves the modified project locally, then commits them for approval.

Step 3: Approval

An RMS user (with the "approval" access control rights) working in TIBCO BusinessEvents WebStudio
receives the request and reviews the checked-in artifacts and then approves or rejects them. The
approved artifacts are available for subsequent checkouts or updates.

Step 4: Generating Deployable Files

An RMS user generates deployable files for resources that are ready for deployment. You can generate
EAR files or class files.

Step 5: Deployment

EAR files are deployed in the usual way, as explained in TIBCO BusinessEvents Administration. Class
files for decision tables and rule template instance files for business rules are deployed by placing them
in a configured location recognized by the TIBCO BusinessEvents engines at start. They can also be hot-
deployed.

Display Models in WebStudio
Using display models, you can display text for the artifact and its properties in a simpler form and your
preferred language. You can also hide some properties of the artifact using display models.

In the WebStudio run time, the display text for the properties, which are defined in the display model,
are displayed instead of the element name. The display model for the artifact and its properties are
created in the TIBCO BusinessEvents Studio. See the TIBCO BusinessEvents Developer's Guide for more
details on how to create display models.

Business Rule Editor

In the Business Rule editor, the display text for the fields are displayed instead of their element name. If
the property is left unspecified in the display model, the element name is displayed. Also, those
properties are displayed for which the hidden check box was not selected.
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Display Text in Business Rule Editor

Decision Table Editor

In the Decision Table editor, the display text is displayed in the column heading and also for the
arguments under the Decision Table in the Group Content section. All the arguments which are marked
as hidden in the display model are not displayed.
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Display Text in Decision Table Editor

Group Contents

In the Group Contents section, all the base artifacts, which have display models defined, have their
display text displayed instead of the artifact name.

Other Language

When the locale for WebStudio is set to a non-default language in the URL, the display model for that
language is loaded in the WebStudio. For example, if the locale is set for German in the WebStudio
URL, such as, http://localhost:8090/WebStudio/?locale=de, the display model with the language defined
as German is picked up and used.
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German Display Model

If the display model with the language and country does not match any language packs, only the
display model for that language is loaded in the WebStudio. The default language 'en_US' will be
picked up for WebStudio display.

Decision Table
A decision table row represents a business rule. It has one or more conditions and one or more actions.

Each condition cell is equivalent to one condition (one line) in the TIBCO BusinessEvents rule editor
condition area. Similarly each action cell is equivalent to one action (one line) in the TIBCO
BusinessEvents rule editor action area (that is, one rule). Decision table rules are like business rules. The
rule that calls the virtual rule function that implements the decision table participates in inferencing in
the usual way. When the virtual rule function is called, the decision table rules are applied.

Conditions and Actions

The columns of a decision table are made up of condition columns on the left, and action columns on
the right. Each column represents one condition or one action.

A condition is a test that must evaluate to true before the action is executed. If a decision table rule uses
multiple conditions, all the conditions for a row must evaluate to true for the action to execute.

In each row (rule) you define the specific conditions and actions. For example, if a condition column is
Age (using a concept property of that name), then each row can define a different age range. The action
for each row would define what action to take if a given concept instance contains an age property
within the specified range.

If you add a second condition column called Income, then before the action is taken, a concept instance
would be tested to see if both the age and the income are within the ranges specified in the rule’s
conditions.

Conditions that are blank, contain an asterisk, or are disabled are ignored, and are treated as if they
evaluate to true.

Regular and Custom Conditions and Actions

Regular condition
It is the value of an entity specified in the virtual rule function scope, or a simple comparison with the
value - is greater than, is less than, is greater than or equal to, is less than or equal to.

Custom condition
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It can use the rule language, standard functions, and data in the scope of the function at runtime (for
example, scorecards and global variables). It can contain complex formulas.

Regular action
It sets the value of an entity specified in the VRF scope.

Custom action
The action can use the rule language, standard functions, and data in the scope of the function at
runtime to do whatever is desired. For example, the action could be to send an event out to a different
system for follow-up.

Using non-literal values in a regular condition or regular action
 Suppose event A and event B are in scope, and event A has property ZZ, and event B has property
YY. Both properties belong to the same data type. Suppose you then drag property ZZ to a condition
or action column. In the cell, you can then specify a value as b.YY. The effect is different depending on
the type of column:

● In a condition column, this means: compare the value of property ZZ with the value of property
YY.

● In an action column this means: set the property ZZ to the value of YY.

Decision tables are available in TIBCO BusinessEvents WebStudio in the view or edit mode only if you
have the TIBCO BusinessEvents Decision Manager add-on installed on your system.
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Configuring RMS

Artifacts needs to be added to RMS, so that they can be used by TIBCO BusinessEvents WebStudio.
Advanced configuration might also be required to enable certain features, such as, SSL authentication.

Adding a Project to RMS
TIBCO BusinessEvents projects, with VRF and rule templates, need to be added to the RMS repository
to make them accessible in the TIBCO BusinessEvents WebStudio.

All RMS projects exist in a repository under a root location directory and their access control list (ACL)
file exist under a RMS configuration directory. The default root location directory (as shipped) is
BE_HOME/examples/standard/WebStudio and the default RMS configuration directory (as shipped)
is BE_HOME/rms/config/security . You can configure the root location by configuring the
ws.scs.rootURL property and the RMS configuration directory location by configuring the
ws.projects.acl.location property in the RMS.cdd file.

Prerequisites

A TIBCO BusinessEvents project created in TIBCO BusinessEvents Studio.

Procedure

1. Under the RMS project root location directory, create a directory with a name appropriate for the
project.

The root location is configurable. See Configuring RMS Server Properties.

2. Copy the TIBCO BusinessEvents Studio project contents that will be used in Decision Manager add-
on or in TIBCO BusinessEvents WebStudio to the project directory.

3. If the project contains custom functions, create the ProjectName directory under the directory
identified by the ws.projects.customLib.location property in the RMS.cdd file and then place
the custom function jars under it. See RMS Server Configuration Property Reference for more
information on the property.

4. Copy the access control file for the project (RMSProjectName.ac) to the RMS configuration
directory. See TIBCO BusinessEvents Administration for authentication topics.

The RMS configuration location is configurable. See Configuring RMS Server Properties.

5. Restart the RMS server.

What to do next

You can also add a project to the RMS repository while the RMS is running using the existing RMS
configurations. During run time, to add a project to the RMS repository, copy the project files to the
RMS project root location and its ACL file to the RMS configuration directory. The project is then
available for check out from the RMS repository. For more information, see Importing a Project to
TIBCO BusinessEvents WebStudio on page 40.

Configuring RMS Server Properties
RMS works out of the box on a local machine. Configuration is required to enable access by remote
TIBCO BusinessEvents WebStudio and the Decision Manager clients.

You may need to make other changes to the server configuration. For example, if you change the server
location or the location of the RMS project repository, you must update the RMS server properties
accordingly.
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To configure the RMS server properties, edit the RMS.cdd file. You cannot edit a CDD file in TIBCO
BusinessEvents Studio outside of its project context. To edit the CDD in TIBCO BusinessEvents Studio,
import the BRMS project into your workspace. After that, copy the RMS.cdd file to its installed
locations, in the following way

Whenever you change the RMS.cdd file you must restart the RMS server so that it uses the updated
values.

See RMS Server Configuration Property Reference for information about each property.

● As with any procedure that changes files, first backup any files that could be affected. The RMS.cdd
file is located in two places, in the product as shipped:

— BE_HOME/rms/project/BRMS/Deployment/RMS.cdd

— BE_HOME/rms/bin/RMS.cdd

● After you update the RMS.cdd file in your workspace, overwrite the existing files with the updated
ones, in the above locations (or the ones currently in use, if different).

● Ensure that the CDD files in the BRMS project and the RMS startup directory are kept in sync.

Procedure

1. In TIBCO BusinessEvents Studio, choose File > Import > Existing Projects into Workspace.

2. Ensure the Copy the projects into workspace check box is selected.

3. Select the following project:
   BE_HOME/rms/project/BRMS

4. In Studio Explorer, double-click RMS.cdd to open it in the CDD editor.

5. In the CDD editor Cluster tab, click Properties. In the Configuration panel on the right, expand
groups to see the individual properties. Update the properties value, as per your requirement, as
explained in RMS Server Configuration Property Reference.

6. When you have finished editing, save the RMS.cdd file.

7. In the file system, copy the RMS.cdd file from your workspace to the BRMS project and to the RMS
server startup location.:
The locations are:

● BE_HOME/rms/project/BRMS/Deployment/RMS.cdd

● BE_HOME/rms/bin/RMS.cdd

8. Restart the RMS server.

Enabling Remote Connection to RMS from WebStudio
For production settings, specify the RMS server hostname and port to ensure that TIBCO
BusinessEvents WebStudio users can connect to RMS from remote machines.

As shipped, the tibco.clientVar.Webstudio/hostname property is set to localhost. This setting
enables the product to be used on a single machine.

Procedure

1. Import the BRMS project into your workspace and open the RMS.cdd file for editing. See 
Configuring RMS Server Properties for details.

2. In the CDD editor Processing Units tab, click WS-Inference. In the Properties panel on the right,
expand the WS property group.
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3. Specify the TIBCO BusinessEvents WebStudio hostname and port using the following properties:

● tibco.clientVar.Webstudio/hostname

● tibco.clientVar.Webstudio/port

4. Save the RMS.cdd file.

5. In the file system, copy the RMS.cdd file from your workspace to the BRMS project and to the RMS
server startup location. The locations are:

● BE_HOME/rms/project/BRMS/Deployment/RMS.cdd

● BE_HOME/rms/bin/RMS.cdd

6. Restart the RMS server.

Enabling SSL Authentication in RMS
The SSL authentication process uses certificates that are issued by a certificate authority. The same
process applies if the certificates are issued by a certificate generation utility or if self-signed certificates
are used.

To establish a SSL connection an application acting as an SSL client contacts an application acting as an
SSL server. You can establish either a one-way SSL authentication or two-way SSL authentication for the
application.

Enabling One-way SSL Authentication in RMS
One-way SSL authentication enables the application operating as the SSL client, which in this case is
web browser, to verify the identity of the application operating as the SSL server (RMS). The SSL-client
application is not verified by the SSL-server application.

Procedure

1. Import the BRMS project in the TIBCO BusinessEvents Studio and copy it into your workspace.
Now open the RMS.cdd file for editing. See Configuring RMS Server Properties for details.

2. In the CDD editor Processing Units tab, click default.
In the Properties panel on the right, you can see the be.channel.deactivate property.

3. Remove the /WebStudio/Core/Channels/WS_CH_Secure_WebstudioChannel value from the
be.channel.deactivate property.

4. Save the RMS.cdd file.

5. In the file system, copy the RMS.cdd file from your workspace to the BRMS project and to the RMS
server startup location.
 The locations are:

● BE_HOME/rms/project/BRMS/Deployment/RMS.cdd

● BE_HOME/rms/bin/RMS.cdd

   

6. Restart the RMS server.

Result

To verify, type the URL https://localhost/WebStudio/ in a web browser and press Enter. No port is
required as default SSL port is used. The web browser notifies you about the untrusted certificate from
the SSL server.
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Enabling Two-way SSL Authentication in RMS
In two-way SSL authentication, the SSL client application, which in this case is a web browser, verifies
the identity of the SSL server application (RMS), and then the SSL server application verifies the
identity of the SSL-client application.

Procedure

1. Follow the steps mentioned in the Enabling One-way SSL Authentication in RMS to enable the SSL
server verification, but do not restart RMS server yet.

2. In Studio Explorer, double-click BRMS > WebStudio > Core > Transports >
WS_TR_Secure_WebstudioHTTPConnection.sharedhttp to open it in the resource editor.

3. In the resource editor, click Configure SSL.
The SSL Configuration for HTTPS Connections window is displayed.

4. In the SSL Configuration for HTTPS Connections window, select the Requires Client
Authentication checkbox and click OK.

5. In the BusinessEvents Studio, regenerate the BRMS project EAR file (RMS.ear) and save it at
BE_HOME/rms/project/. See TIBCO BusinessEvents Developer's Guide for more details.

6. Restart the RMS server.

7. Open your web browser and import the WSClientStore.p12 certificate file in the web browser
from the location BE_HOME/rms/config/security/. Refer to your web browser’s help on how to
import certificate in it.

Result

To verify, type the URL https://localhost/WebStudio/in the same web browser and press Enter. No
port is required as default SSL port is used. The web browser displays a confirmation window to select
your SSL client certificate and send it to the SSL server. After that the web browser notifies you about
the untrusted certificate from the SSL server.

Updating Shared JDBC Connection in Runtime
Edit the RMS.cdd file to add the JDBC connection to the backing store from RMS at runtime.

Procedure

1. Import the BRMS project in the TIBCO BusinessEvents Studio and copy it into your workspace.
Now open the RMS.cdd file for editing.
See Configuring RMS Server Properties for details.

2. In the CDD editor Cluster tab, click the Properties in the Cluster pane and expand node under the
Configuration pane.

3. Expand the BackingStore property group and edit the value for backing store properties as
required.
See Backing Store Property Group for more details on the properties.

4. Save the RMS.cdd file

5. In the file system, copy the RMS.cdd file from your workspace to the BRMS project and to the RMS
server startup location.
 The locations are:

● BE_HOME/rms/project/BRMS/Deployment/RMS.cdd
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● BE_HOME/rms/bin/RMS.cdd

   

6. Restart the RMS server.

Enabling WebStudio Client Side Logging
You can enable the logs for the WebStudio client for logging messages that are submitted by the client.
WebStudio client-side logging can be enabled by configuring the intended logging flags in the
WebStudio.html file.

WebStudio client-side logging is different from RMS logging, which can be configured using the
RMS.cdd file.

Procedure

1. Go to the BE_HOME/rms/bin/ folder and extract the WebStudio.war package in a separate folder.

2. From the extracted files, open the WebStudio.html file in the edit mode.

3. In the WebStudio.html file, set the JavaScript variable webstudio_logging_enabled to true.
The WebStudio client-side logging is now available.

4. Save the WebStudio.html file and repackage all the extracted files to the WebStudio.war package.

5. Restart RMS.
The WebStudio client log is created at BE_HOME/rms/bin/logs/webstudio_client.log.

Defining Temporary Files Storage Folder for RMS
Every time you restart RMS, a new httpRoot is created to store temporary data. You can modify this
setting so that the temporary data is stored in the same location after every restart. To specify the
location where temporary data must be stored, configure the com.tibco.be.http.root property.

Procedure

1. Open the RMS.cdd file or the be-rms.tra file for editing.
These files are located at BE_HOME/rms/bin.

2. Add the com.tibco.be.http.root property and set the value to the temporary folder location.
For example,
com.tibco.be.http.root=C:/temp/RMSHTTPRootTmp

Ensure that the specified folder is already present before restarting RMS.

3. Restart RMS.

Result

Now, RMS uses the specified folder (for example, RMSHTTPRootTmp) to store temporary data and
does not create a new temporary folder on each restart.

RMS Server Configuration Property Reference
To configure the RMS server properties, edit the RMS.cdd file.

See Configuring RMS Server Properties for the related procedure.

Properties not documented in this table are either for internal use or are for other types of configuration
explained elsewhere in the documentation.
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Common Property Group

Property Default Value Description

rms.checkin.revisionI

d.initValue

10000 Initial value of the revision number to
use for project check in.

ws.artifact.deploy.lo

cation

BE_HOME/rms/shared Name of the directory for storing EAR
files that are generated for deployment.
Separate directory for each project is
created, where EAR files for the project
are stored.

See also be.codegen.rootDirectory.

be.codegen.rootDirect

ory

Codegen Name of the directory for storing class
files generated by the Generate
Deployable menu option. The directory
location is relative to the
ws.artifact.deploy.location

directory.

If this property is not present, then files
are stored in the deployment directory.

If this property is present but has no
value, a directory is created with the
default name Codegen.

be.codegen.useLegacyC

ompilation

False Set the value to true, if you want to use
the file-based legacy compiler to build
the EAR file. By default, the value is
false, that means EAR files are built in
memory.

ws.projects.customLib

.location

BE_HOME/rms/lib/ext Path of the directory for storing custom
function libraries for a WebStudio
project. The custom function libraries
are saved in a folder (with the same
name as of the project name) inside the
directory identified by the
ws.projects.customLib.location

property.

For example, if the value of the
ws.projects.customLib.location

property is C:/Tibco/
BE52/be/5.2/rms/lib/ext, then the
custom function libraries for the
MyTestProject project should be saved
in the location C:/Tibco/
BE52/be/5.2/rms/lib/ext/

MyTestProject.

24

TIBCO BusinessEvents® WebStudio User's Guide



Property Default Value Description

ws.projects.projectLi

b.location

BE_HOME/rms/project-
lib

Path of the directory for storing project
libraries for a WebStudio project. The
project libraries are saved in a folder
(with the same name as of the project
name) inside the directory identified by
the
ws.projects.projectLib.location

property.

For example, if the value of the
ws.projects.projectLib.location

property is C:/Tibco/
BE52/be/5.2/rms/project-lib, then
the project libraries for the
MyTestProject project should be saved
in the location C:/Tibco/
BE52/be/5.2/rms/project-lib/

MyTestProject.

ws.validateDT.ignoreD

eployableStatus

false Specifies whether to ignore the
deployment status of the artifact at
server restart and perform decision
table validation without regenerating
deployables.

This property is required when
persistence is not enabled for the
system. When the persistence is
enabled, this property is not needed as
the deployment status is available
across server restarts.

RMS Property Group

Property Default Value Description

rms.project.workspace workspace Not used in this release

rms.project.decisiond

ata

decisiondata Not used in this release

rms.project.deploymen

t

deployment Not used in this release

rms.workflowstages.co

nfig.file

BE_HOME/rms/config/
RoleWorkflowStages.xml

Not used in this release

rms.lockworkflowstage

s.config.file

BE_HOME/rms/config/
LockWorkflowStages.xml

Not used in this release

Default is BE_HOME/rms/config/
LockWorkflowStages.xmL
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Property Default Value Description

rms.roleArtifactTypes

.config.file

BE_HOME/rms/config/
RoleApplicableArtifactT

ypesConfig.xml

Not used in this release

Default is BE_HOME/rms/config/
RoleApplicableArtifactTypesConfi

g.xml

rms.external.entities

.autodetect

Used internally. Do not change the
value.

Authentication and Authorization (ACL) Properties

User authentication topics are common to TIBCO BusinessEvents and the add-on products that use
authentication. Common options are fully documented in TIBCO BusinessEvents Administration. The
relevant properties are also listed as follows for your convenience.

Property Default Value Description

be.auth.type Specifies the authentication mechanism
used. Additional configuration is
required. The values are:

● file

● ldap

● openldap

Note:  Authentication topics are
documented in the TIBCO
BusinessEvents Administration guide.

be.auth.file.location BE_HOME/rms/config/
security/users.pwd

Location of the authentication file used
for file-based authentication.

Note:  Authentication topics are
documented in the TIBCO
BusinessEvents Administration guide.

java.security.auth.lo

gin.config

BE_HOME/rms/config/
security/jaas-

config.config

Location of the JAAS login
configuration file. You can substitute a
different implementation of the JAAS
login module than the one provided.

Note:  Authentication topics are
documented in the TIBCO
BusinessEvents Administration guide.

ws.projects.acl.locat

ion

BE_HOME/rms/config/
security

Location of the directory used for all
ACL (authorization) files. Files must be
named using the format
RMSProjectName.ac.
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RMS-GVs Property Group

This group of properties override the values of global variables that are provided in the TIBCO
BusinessEvents Studio BRMS project. These properties are made available as global variables so that the
properties can be overridden at runtime, as needed.

You can override the default global variable values in the RMS.cdd file for command-line startup. For
details on overriding global variable values when deploying with TIBCO BusinessEvents Monitoring
and Management or with TIBCO Administrator, see TIBCO BusinessEvents Administration.

For defining and using global variables in TIBCO BusinessEvents Studio projects, see TIBCO
BusinessEvents Developer’s Guide.

Property Default Value Description

tibco.clientVar.RMS/

hostname

localhost Specifies the host name or IP address of
the machine where RMS is hosted.
Remote clients can connect to the server
at this location.

tibco.clientVar.RMS/

port

5000 Specifies the port number of the
machine where RMS hosted. This port
is used for listening to client requests.
See notes for tibco.clientVar.RMS/
hostname.
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Property Default Value Description

tibco.clientVar.RMS/

Approval/adminRole

Administrator The multiple roles specified here have
Administrator role permissions. When
you change the default value, the
Administrator role still has
Administrator permissions.

You can also specify project specific
administrator roles. To specify project
specific admin roles, append the role to
the project name separated by a colon
(:). Ensure that the role has the
approve permission set for the project.

For example,
tibco.clientVar.RMS/Approval/
adminRole =  
Administrator;CreditCardApplicat
ion:Business-User

This shows the worklist items for the
CreditCardApplication project, for
users with the Business_User roles,
while for all other projects, the worklist
items show up for users under the
Administrator role.

Ensure that you replace the XML
special character in the administrator
role name value (if present) with the
following characters:

● "&" by "&amp;"

● " ' " by "&apos;"

WebStudio Property Group

Property Default Value Description

tibco.clientVar.Webstudio/
warDir

rms/bin/WebStudio.war Path to the Web archive for the client
side representation of the TIBCO
BusinessEvents WebStudio.

tibco.clientVar.Webstudio/
hostName

localhost Specifies the host name or IP address of
the machine where RMS server is
hosted for WebStudio.

tibco.clientVar.Webstudio/
port

8090 Specifies the port number of the
machine where RMS server is hosted
for WebStudio. This port is used for
listening to client requests. See notes
for tibco.clientVar.RMS/hostname.

tibco.clientVar.Webstudio/
Connection/timeout

60000 Timeout interval for the HTTP channel.
This value is in milliseconds.
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Property Default Value Description

tibco.clientVar.Webstudio/
sessionTimeOut

30 Time interval for which an inactive user
session will be valid. This value is in
minutes.

tibco.clientVar.Webstudio/
DecisionTable/pageSize

20 Number of rows of the decision table to
be displayed in a page.

ws.validateDT.temp.dir rms/temp-dir Directory which is used as an interim
storage of decision table contents
during the validation process.

Global Variable Properties for One-Way SSL Between RMS Server and Decision Manager Clients

Property Default Value Description

tibco.clientVar.RMS/

security/securePort

8443 The port to be used for secure HTTP
communication in BusinessEvents
Studio.

tibco.clientVar.RMS/

security/

sslCertificateStore

BE_HOME/rms/config/

security/SSLKeyStore.ks

Absolute path of the JKS KeyStore
which contains the RMS server's public/
private keys. If the certificate used is
CA signed, include the CA's certificate.

tibco.clientVar.RMS/

security/

sslCertificateStorePa

ssword

changeit The password for the KeyStore.

tibco.clientVar.RMS/

security/

secureWebPort

443 The port to be used for secure HTTP
communication in WebStudio.

Properties for One-Way SSL Between LDAP Server, RMS Server, and Decision Manager Clients

● For one-way SSL between LDAP server and RMS server, you must also change the value of
be.auth.ldap.port.

● For one-way SSL between RMS server and Decision Manager clients, you must also set the value of
be.auth.ldap.port.

Property Default Value Description

be.auth.ldap.ssl If set to true, enables SSL between the
RMS server and the LDAP server

If set to false or not set, the LDAP
authentication uses a non-secure
channel.
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Property Default Value Description

javax.net.ssl.trustSt

ore

The absolute path of the KeyStore
containing the LDAP server certificate
chain.

javax.net.ssl.trustSt

orePassword

The password for the KeyStore.

javax.net.ssl.trustSt

oreType

The KeyStore type for KeyStores other
than JKS type, for example, PKCS12.

Email Notification Property Group

Email notification properties are used to send email notification when an artifact undergoes a status
change in approval workflow, such as, artifact commit and artifact review (Approve, Reject,
BuildAndDeploy).

In addition to these properties, you can define any SMTP protocol specific properties depending on the
mail server configuration. These properties should be defined with a prefix ws.notify.prop, for
example, ws.notify.prop.mail.smtps.auth, ws.notify.prop.mail.smtps.ssl.enable.

Property Default Value Description

ws.notify.enabled False If set to true, send email notification.

If set to false, do not send email
notification.

ws.notify.file.locati

on

BE_HOME/rms/config/

notify/UserNotify.Ids

Specifies the location of the .IDS file
which contains the mapping of
WebStudio user IDs to the email IDs.
This field is used in the case of file-
based authentication.

ws.notify.ldap.userNo

tifyIdAttr

userPrincipalName Specifies the name of the LDAP
attribute for the email ID. This field is
used in the case of LDAP based
authentication.

ws.notify.impl.class com.tibco.be.ws.notific

ation.impl.EmailNotific

ation

Specifies the implementation class for
email notification support.

ws.notify.context.imp

l.class

com.tibco.be.ws.notific

ation.impl.EmailNotific

ationContext

Specifies the context implementation
class for email notification support.

ws.notify.message.tem

plate.file

BE_HOME/rms/config/

notify/message.stg

Specifies the location of the message
template file, which contains template
(subject and content) for the commit,
reject, and approve notification emails.
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Property Default Value Description

ws.notify.mail.domain Specifies the domain on the email. This
is used with the RMS username to
construct the email address to which
the notification is to be sent. For
example, if RMS username is “admin”
and the property is set to “tibco.com”,
the email address for the notification is
admin@tibco.com.

ws.notify.mail.receiv

er.cc.emails

Comma-separated list of email IDs or
WebStudio user IDs to whom any
commit, approve, or reject notifications
need to be sent. In the case of CC
notifications to the WebStudio users,
specify their login IDs. The email IDs
are picked up from the .IDS file
identified by the
ws.notify.file.location property, if
present; otherwise, the email ID is
evaluated as <login-ID>@<mail-domain>.

In the case of LDAP based
authentication, the email ID is picked
up from the user's LDAP entry.

ws.notify.prop.MAIL_P

ROTOCOL

SMTPS Specifies the email protocol to be used
to send the email. SMTP and SMTPS are
valid values.

ws.notify.prop.MAIL_S

ERVER_HOST

Specifies the host name of the email
server.

ws.notify.prop.MAIL_S

ERVER_PORT

Specifies the port at which the mail
server is listening.

ws.notify.prop.SENDER

_EMAIL

Specifies the email address to be used
for sending the notification email.

ws.notify.prop.SENDER

_USERNAME

Specifies the sender’s username for
authentication to email server.

ws.notify.prop.SENDER

_PASSWORD

Specifies the sender’s email password
for authentication to email server.

ws.notify.prop.mail.s

mtps.auth

true This is a SMTP protocol-specific
property. Specifies whether the
authentication is checked or not for the
email server.

ws.notify.prop.mail.s

mtps.ssl.enable

true This is a SMTP protocol-specific
property. Specifies whether the email
server is SSL enabled.
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Hot Deployment Property Group

Use the hot deployment property group to configure JMX connection details in the CDD file and hot
deploy the business rule and the decision table directly from WebStudio. You can configure JMX
connection details for each project for each environment. Using these properties you can deploy
multiple projects in multiple environments. For example, for deploying the CreditCardApplication
project in the "QA" environment, set the QA environment in the
CreditCardApplication.ws.applicableEnvironments property and set the JMX connection details
in the CreditCardApplication.QA.ws.jmx.* properties.

You can also edit these properties in the WebStudio new user interface under the Deployment
Preferences tab in the Settings page. For more details, see Settings Page Reference on page 71.

Property Default Value Description

<ProjectName>.ws.applicab

leEnvironments

QA,PROD Specifies the environment where the
artifacts can be deployed.

Add this property for each project
you want to deploy. For example, if
you want to deploy the
CreditCardApplication project in the
PROD and the QA environment, set
the
CreditCardApplication.ws.applic

ableEnvironments property value to
"PROD,QA".

<ProjectName>.<Environmen

tName>.ws.jmx.hotDeploy.e

nable

true Specifies whether to enable or disable
hot-deployment (as part of
BuildAndDeploy operation) for the
specified project in the specified
environment. This works only for
cache based projects.

<ProjectName>.<Environmen

tName>.ws.jmx.inMemory

false Specifies whether to enable hot
deployment for the inMemory based
projects.

Do not specify for cache based
projects.

<ProjectName>.<Environmen

tName>.ws.jmx.host

localhost The name of the JMX host.

<ProjectName>.<Environmen

tName>.ws.jmx.port

9990 The unused port number, through
which you want to enable the JMX
connection.

<ProjectName>.<Environmen

tName>.ws.jmx.user

The username for the JMX
connection.

<ProjectName>.<Environmen

tName>.ws.jmx.password

The password for the user name for
<ProjectName>.<EnvironmentName>

.ws.jmx.user.
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Property Default Value Description

<ProjectName>.<Environmen

tName>.ws.jmx.clusterName

The name of the cluster to be
monitored.

<ProjectName>.<Environmen

tName>.ws.jmx.agentName

inference-class The name of the TIBCO
BusinessEvents agent.

Backing Store Property Group

Use the backing store property group to add a shared JDBC connection without the need to build the
new EAR file (RMS.ear) for the BRMS project.

Property Default Value Description

tibco.clientVar.Webstudio/
DB/driverName

oracle.jdbc.OracleDriver The name of the JDBC driver class.

tibco.clientVar.Webstudio/
DB/url

jdbc:oracle:thin:@localhos

t:1521:orcl

The URL to use to connect to the
database. You must supply the
portions of the URL, for example,
the host, port number, and database
instance name. .

tibco.clientVar.Webstudio/
DB/maxConnections

5 The maximum number of database
connections to allocate. The
minimum value that can be
specified is 1.

tibco.clientVar.Webstudio/
DB/userName

User name to use when connecting
to the database.

tibco.clientVar.Webstudio/
DB/password

Password to use when connecting to
the database.

tibco.clientVar.Webstudio/
DB/timeout

zero Time (in seconds) to wait for a
successful database connection.
Only JDBC drivers that support
connection timeouts can use this
configuration field. If the JDBC
driver does not support connection
timeouts, the value of this field is
ignored. Most JDBC drivers support
connection timeouts.

Source Control System (SCS) Property Group

SCS property group enables you to check out a WebStudio project resources from a SCS location and
commit the updates.
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Property Default Value Description

ws.scs.rootURL BE_HOME/examples/
standard/WebStudio

Specifies the RMS repository location.
This is the root location for RMS project
directories.

If repository is present in source
control, then provide the repository
URL of RMS projects as the value of
ws.scs.rootURL .

If you want to configure multiple RMS
project locations, you can specify them
separated by commas.

ws.scs.impl.type file Identifies the type of repository being
referred. The values that configured in
the product out-of-the-box are:

● file (default)

● svn

ws.scs.repo.dir BE_HOME/rms/repo The local repository directory on your
system. All checked out project
resources are downloaded at this
location.

ws.scs.command.path Absolute path to the source control
command line client.

For example, if SVN is used then RMS
server uses the SVN command line tool
to connect to the SVN repository. Any
SVN command line tool can be used,
one commonly used one being Tortoise
SVN CLI.

ws.scs.default.userna

me

Default username to connect to the
repository mentioned in the
ws.scs.rootURL property.
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Property Default Value Description

ws.scs.default.passwo

rd

Default password, encoded into the
Base64 format, to connect to the
repository mentioned in the
ws.scs.rootURL property.For
example, Password123 should be
encoded with Base64 format and
entered as UGFzc3dvcmQxMjM=.

Note: WebStudio uses the default
username and password (after
decoding from Base64 format) to check
out and check in the objects from the
SVN repository. You also have the
option to enter your SCS username and
password (in the Preference portlet
under the Settings tab) in the
WebStudio UI which overrides the
default username and password. Enter
the actual password in the WebStudio
UI and not a Base64 format encoded
one. See Preferences Settings for more
details.

ws.scs.locking.enable false You can lock the artifacts for the
WebStudio. If the lock is applied on an
artifact, the other users cannot modify
or delete the artifacts until the lock is
released.

ws.scs.lock.timeout 0 Time in seconds before the lock is
automatically released. Set the
property value greater than zero to
apply timeout on locks.

Cross-Origin Resource Sharing (CORS) Property Group

Using the CORS property group, you can specify which external applications can use the WebStudio
APIs.

Property Default Value Description

be.http.filter.cors.class org.apache.catalina.

filters.CorsFilter

The filter class name for the CORS
filter.

35

TIBCO BusinessEvents® WebStudio User's Guide



Property Default Value Description

be.http.filter.cors.param

.cors.allowed.origins

* A list of Origin request header values
that are allowed to access the
resource..

BusinessEvents matches the value of
Origin header of the HTTP request
with this list. If the Origin request
header value is present in the list, then
the Access-Control-Allow-Origin
header in the HTTP response returns
the Origin request header value.

The default value is "*"
which means all URLs are valid, and
the Access-Control-Allow-Origin
header in the HTTP response returns
"*" for all requests.

be.http.filter.cors.param

.cors.allowed.methods

GET,POST,DELETE,PUT A list of HTTP methods that can be
used to access the resource, using
cross-origin requests. These are the
methods which will also be included
as part of Access-Control-Allow-
Methods header in pre-flight response.

be.http.filter.cors.urlpa

ttern.1

/* The URL pattern that triggers the
filter.

Integrating Custom Repository with RMS
TIBCO BusinessEvents provides API to integrate your repository with RMS. You can use this repository
to store RMS projects.

You can use the com.tibco.be.ws.scs.impl.repo API to create implementation classes for your
repository to integrate with RMS. TIBCO BusinessEvents provides a sample implementation (SVN
repository) of this API at BE_HOME/examples/standard/WebStudio/CustomRepository.

For details about the com.tibco.be.ws.scs.impl.repo API and its classes, see TIBCO BusinessEvents
Java API Reference.

Procedure

1. Create a Java class extending the base implementation class
com.tibco.be.ws.scs.impl.repo.AbstractRepositoryIntegration and implement all its
abstract methods.
The AbstractRepositoryIntegration class is available in the cep-rms.jar file at BE_HOME/rms/
lib. Add this JAR file to the classpath of the newly created Java class to resolve dependencies.
For details about the AbstractRepositoryIntegration class and its methods, see TIBCO
BusinessEvents Java API Reference.
For better understanding of the implementation, refer to the sample implementation class created
for the SVN repository at BE_HOME/examples/standard/WebStudio/CustomRepository/svn/src.

2. If your repository uses a CLI for interaction, install its command line executables.
For details about the CLI installation for your repository, refer to your repository documentation.
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3. After you have created the required implementation class, compile them using JDK and bundle the
class in a JAR file.

4. Copy the JAR file to BE_HOME/rms/lib.

5. Edit the RMS.cdd file located at BE_HOME/rms/bin and set the ws.scs.impl.type property value to
the fully qualified path of the custom implementation class.
For example, for the provided sample SVN implementation, set ws.scs.impl.type as
com.tibco.be.ws.scs.impl.repo.svn.SVNIntegration.

6. If your repository uses a CLI for interaction, in the RMS.cdd file, set ws.scs.command.path property
value to the absolute path of the command line executable.

7. Save the RMS.cdd file and restart RMS.
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WebStudio New User Interface

You can access all the RMS artifacts in a new refreshed user interface in WebStudio. In the new user
interface you can perform the same operations as you can perform in the classic view with more
intuitive controls.

Basic User Workflow in New UI of WebStudio
In the new UI of WebStudio you can perform all the tasks with ease.

The following is a list of basic tasks that you can perform on the new UI of WebStudio:

1. Start the rule management server and log in to WebStudio, see Signing-in to WebStudio on page 38.

2. After successful log in, check out a project from RMS repository to work on it, see Checking Out an
RMS Project on page 41.

3. Generate the EAR file for the project, see Generating the Project EAR and Class Files in New UI on
page 50.

4. Create a new decision table or business rule, or update an existing decision table or business rule.

For details on how to create a new decision table, see Creating a Decision Table on page 56.

For details on how to create a new business rule, see Creating a Business Rule on page 62.

For details on decision table editor, see Decision Table Editor Reference on page 56.

5. Save and commit the updates to new or existing decision tables and business rules. You can use the
Commit option in the context menu of the artifact (see Commit on page 45), or click the Commit
button in the editor.

6. In the Dashboard tab, approve the commit request, see Approving or Rejecting a Commit Request
from the Worklist in the New UI on page 51.

7. After the commit request is approved, on the Dashboard tab, deploy the approved request at
runtime, see Deploying an Updated Artifact to the Application from the New UI on page 55.

Signing-in to WebStudio
In WebStudio, you have the option to sign-in either in the classic UI or in the new UI.

Procedure

1. Start the RMS server by using one of the following ways:

● Run BE_HOME/rms/bin/be-rms.exe (or be-rms.sh, depending on your operating system),
with valid arguments. For example, on Windows you would open a command window in
BE_HOME/rms/bin and execute:
   be-rms.exe

● (Windows only) Select Start > All Programs > TIBCO > TIBCO_HOME > TIBCO
BusinessEvents <version> > Start Rules Management Server.

The server is ready when you see a message in the command window such as:
Info [HTTP-Channel-Startup] - [driver.http] Channel server for HTTP Channel 
[Port:5000] successfully started

2. Type the URL http://host:port/WebStudio/ in a web browser. Default host is localhost and default
port is 8090. Host and port are configurable using properties in RMS.cdd. Ensure that the RMS is
running before logging to TIBCO BusinessEvents WebStudio.

3. On the Sign In page of the new UI, enter user name and password and click Sign In.
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TIBCO BusinessEvents WebStudio Sign In Page

Result

After successful login, the WebStudio welcome page or the WebStudio Dashboard is displayed. This
Welcome page is only displayed if no project is already checked out. WebStudio automatically ends any
other session of the user and make this session as the active session. For details about the TIBCO
BusinessEvents Dashboard, see TIBCO BusinessEvents WebStudio Dashboard Reference on page 39.

TIBCO BusinessEvents WebStudio Dashboard Reference
The BusinessEvents WebStudio welcome page displays your information as a user. You can then
navigate to settings and management page, and also check out the projects from this screen.

WebStudio Welcome Page

Eleme
nt No. Element Description

1 Switch to Classic
View

Click the Switch to Classic View button to switch to the classic UI of
WebStudio. If any project is checked out in the new UI, the same
project is checked out in the classic UI too.
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Eleme
nt No. Element Description

2 <username> Displays the user name of the logged in user. You can also log out
using this button. Click the button and select Log Out.

3 WebStudio Menu Click the Menu icon to display list of options available in WebStudio.

● Help - Link to the TIBCO BusinessEvents Online Documentation.

● API Documentation - Link to the RMS REST API documentation.

4 Workspace Tab Workspace where you can modify the manageable artifacts using
their respective editors.

5 Dashboard Tab Click on the Dashboard tab to display the worklist items that need
approval or that can be deployed. This is the default tab.

6 Settings Tab Set your preferences for users and application. For details, see 
Settings Page Reference on page 71

7 Management Tab Use this tab for users, user roles, locks on artifacts and reports.

8 You have
unresolved items

Displays the number of unresolved items that you can either
approve, reject, or delegate.

9 Recent User
Activity

You can view all the activities that you have performed in the user
timeline. The recent user activity also provides a search option and
advance filters to filter out activities on timeline.

10 Project Snapshot You can checkout the project from the project snapshot.

Importing a Project to TIBCO BusinessEvents WebStudio
To work on artifacts like decision tables and business rules of a project, you must first import a project
to TIBCO BusinessEvents WebStudio.

Prerequisites

● To import a project to TIBCO BusinessEvents WebStudio you need a ZIP file of the project.

● The name of the project file and the ZIP file must be the same.

● To be able to import a project, the user must have an administrator role permission.

Procedure

1. You can import a project from the Welcome screen or from the Workspace.

● On the Welcome page, click the Upload icon ( ).

● (On the Workspace tab) Click on the Checkout/Import Project icon ( ) and click Import
Project.

The Import Project dialog opens.
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Importing a Project to TIBCO BusinessEvents WebStudio

2. In the Import Project window, to select a file, click Select.

3. Navigate to the ZIP file location of the project file on your local computer and select that.

4. Click Confirm.

An access control file is generated by default at the default location. You can change
permissions in the access control file from the Management tab. For details, see Managing
Roles on page 76.

What to do next

You can check out the imported project from the Dashboard tab. For more information, see Checking
Out an RMS Project on page 41.

Checking Out an RMS Project
To work on any managed artifact of a RMS project in WebStudio, check out the project item in
WebStudio.

Prerequisites

The project must be present in the RMS repository. For details on how to add project to RMS, see 
Adding a Project to RMS on page 19.

Procedure

1. Log in to the new user interface of WebStudio.
For details on how to login, see Signing-in to WebStudio on page 38.

2. You can check out an RMS project from one of the following:

● Dashoard tab - Click the Check Out Artifacts button on the Project Snapshot.

● Project explorer panel on the Workspace tab - Click the Checkout Artifacts icon.
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The Check Out Artifacts window is displayed.

3. On the Check Out Artifacts window, select the RMS project from the drop-down list. You can then
select the artifacts that you want to check out in WebStudio. Click Confirm to check out the selected
artifacts.
You can use the search bar to filter out the artifact that you want. You can also use the Select All
toggle button for ease in selecting artifacts.

Check Out Artifacts Window

Result

The checked out projects and its artifacts are displayed in the project explorer panel under the
Workspace tab. For more details on the options present on the project explorer panel, see Project
Explorer Panel Reference on page 43.
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Project Explorer Panel Reference
After the successful check out, the entire checked out project artifacts are displayed in the project
explorer panel. In the project explorer you can perform various operations on the artifacts and even
check out other projects. You can also group or view artifacts according to your requirement.

WebStudio Project Explorer Panel

Eleme
nt No.

Element
Name Description

1 Project
Explorer
Head

Displays the type of artifacts that are displayed on the Project Explorer. In
case of the Show Breadcrumbs navigation style, this displays the
breadcrumbs for the artifacts.

2 Filter Enter the filter text to filter the artifacts in the project explorer.

3 Recently
Opened
Artifacts

You can view the list of recently opened artifacts by clicking the down
arrow icon.

4 Checkout
Artifacts/
Import
Project

Click the Plus icon to import a project or check out artifacts of a project.

5 Refresh All
Projects

Refresh the artifacts.
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Eleme
nt No.

Element
Name Description

6 Navigation
Style

Click the Menu icon to select the navigation style for the project explorer.
The following navigation styles are available in the new UI:

● Show resources as a tree - Shows all the artifacts along with their
folder structure in the tree view.

● Show resources as a flattened list - Displays all the artifacts of the
project in a single list. This is the default navigation style.

● Show breadcrumbs - Shows all the artifacts in the folder structure, but
it only displays the artifacts of the selected folder. You can use the
breadcrumbs links displayed on the project explorer head to navigate
through the project.

● Basic tree navigation (no groups) - Shows all the artifacts in the folder
structure. In this navigation style, the artifact groups are not present
for filtering.
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Eleme
nt No.

Element
Name Description

7 Project
Explorer

Displays list of artifacts of the checked out project. You can use the filter,
navigation style, and artifact groups to filter the artifacts list on the project
explorer. Click the managed artifacts (business rule and decision table) to
open them in their respective editor.

Right-click the managed artifacts to open the list of available operations
for them. The available options are as follows:

Delete
Deletes the artifact. Click Confirm on the confirmation screen to delete
the artifact. After deletion commit the changes to the project using the
tree view

Commit
Commits the changes to the artifact for approval. In the Commit
Changes window, enter a comment for the changes in Message text box.
Click the artifact name to review the changes for commit. Click Confirm
to commit the changes to RMS repository.

Synchronize
Synchronizes the update from the server to your local copy of the
artifact. For more details on the fields present on the Synchronize
Artifact window, see Synchronize Artifact Details Window Reference.

Revert
Reverts the update (if not committed) done to an artifact. In the Revert
window, click the artifact name to review the changes to revert. Click
Confirm to revert the changes.

Lock
Locks the artifact for the user and other user cannot commit any
changes to the table until it is unlocked. This option works only if the
ws.scs.locking.enable property is set to true in RMS.cdd.

Rename
Provide a new name to the artifact. After changing the file name,
commit the changes so the artifact is treated as a new artifact.

History
View list of the revisions of the artifact that were committed. For each
revision, you can click View Content to view the revision that was
committed or you can click View Commit to view the revision details.

Audit Trail
Displays the list of actions performed on the artifact by users. You can
refine the results using the filters available in the Audit Trail window.
For more information on the fields, see Management Page Reference.

Export
Exports the artifact to your system. Decision table is exported as an
Microsoft Excel file (.xls) while business rule is exported as
a .ruletemplateinstance file. For details, see Exporting Artifacts
from TIBCO BusinessEvents WebStudio on page 48.

(Project only) Sync to Repository
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Eleme
nt No.

Element
Name Description

Synchronize the (non-managed) project artifacts changes, that you have
made externally after performing check out in WebStudio, into RMS.
Select the option to open Sync To Repository screen, which displays the
list of artifacts that are synced to the repository. Click Confirm to sync
artifacts to RMS.

(Project only) Generate Deployable
Generates deployable files (EAR and class files) using the TIBCO
BusinessEvents Studio project files, located in the RMS project folder.
The deployables are generated in the location configured in the RMS.cdd
file by the property ws.artifact.deploy.location, see Generated
Files Location on page 120.
Select this option to display the Generate Deployable screen. In the
Generate Deployable screen enter the value of the following fields and
click Confirm to generate deployables:

● Project Selected - Select the project for which you want to generate
EAR and class files.

● Generate Classes Only - Toggle the switch to ON to generate only
class files for decision tables and business rules. When set to ON, the
EAR file for the project is not generated.
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Eleme
nt No.

Element
Name Description

8 Artifact
Groups

Select the artifact group to display the respective artifact type in the
project explorer. The values are:

● All Projects - Displays all checked out artifacts.

● Business Rules - Displays only checked out Business Rules.

● Decision Tables - Displays only checked out Decision Tables.

You can also create a custom group where you can add artifacts that you

want. Click on the Create a new artifact group icon ( ), enter the new
group name and click OK. Drag and drop artifacts from the project
explorer to the newly created artifact group to add the artifacts to the
group.

9 Open Editors Displays all the open artifact editors in the workspace
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Exporting Artifacts from TIBCO BusinessEvents WebStudio
You can work on decision tables and business rules in TIBCO BusinessEvents WebStudio and export
them to your local computer.

Prerequisites

The navigation style of the project explorer must be a tree structure. To change the navigation style, on

the project explorer, click the Change the Navigation Style icon ( ) and select Show resources as a
tree.

Procedure

1. In the project explorer, right-click the project name and in the available operations, and select
Export.
The Export Artifacts from window appears.

2. Search and select the artifacts that you want to export.

You can use the Select All toggle to select all artifacts at a time.

3. Click Export.
The selected artifacts are exported in a ZIP file.

What to do next

Extract the ZIP file to obtain the decision tables as Microsoft Excel (.xls) files and the business rules as
rule template instance (.ruletemplateinstance) files.

Synchronizing a Project from RMS Repository
After you log into the RMS server, synchronize your local copy of the project, with the most recent
changes from the RMS server, before continuing to work on it.

Other users might have checked in changes, additions, and deletions that are now available for check
out. There can be other changes too. You can select what updates to accept.

Procedure

1. In the Project Explorer, right-click any project and select Synchronize.
The Synchronize Project window is displayed with all the artifacts for which the updated version is
present on the server.
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Synchronize Project Artifacts

2. Click the artifact to view differences between the server and the local copy.
The Synchronize artifact details window is displayed. For more details about the elements present
on the window, see Synchronize Artifact Details Window Reference on page 49.

3. Click Confirm to apply the changes and click Close.

Result

The synchronization for the artifact is complete and you can see the synchronized copy in the editor.

Synchronize Artifact Details Window Reference
The Synchronize Artifact Details windows helps you to view and synchronize the artifacts from the
repository.

Synchronize Artifact Details Window
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Elem
ent
No.

Element
Name Description

1 Strategy Specifies the synchronizing strategy for the artifact. The values are:

● merge - Merge your local copy of the artifact with the server copy and
you have the option to choose to either keep the server changes or the
local changes.

● latest() - Discard the local copy and keep only the server copy.

2 Latest Toggle to highlight the update from the server copy.

3 Working Toggle to highlight the update from your local copy.

4 Reset Resets all the toggles and changes that you have done on the Synchronize
Artifact window.

5 Legends The legends for the highlighting displayed on the artifact.

6 Conflict
Resolution
Section

Displays the artifact and then updates are highlighted based on the type of
update.

Conflicts are displayed when the same field is updated locally and in the
server. In conflicts both the values are displayed, from which you can select
the value that you want to keep and the value that you want to discard.

Double-click the conflict to open the Conflict Resolution window. Select the
toggle for the value that you want to keep and click Confirm.

Generating the Project EAR and Class Files in New UI
Deployable files are generated using the TIBCO BusinessEvents Studio project files, located in the RMS
project’s folder.

You can generate deployable EAR files only if you have the permission to check out all the required
project resources (ACLs can limit what you can check out). The deployables are generated in the
location configured in the RMS.cdd file by the property ws.artifact.deploy.location, see Generated
Files Location on page 120.
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Procedure

1. In the Project Explorer, click on the Change the navigation style icon and select any of these
navigation style:

● Show resources as a tree
● Show breadcrumbs
● Basic tree navigation (no groups)

The project is displayed in the Project Explorer.

2. Right-click the project name and select Generate Deployable.

3. On the Generate Deployable screen, enter the value of the following fields and click Confirm to
generate deployable files.

● Project Selected - Select the project for which you want to generate EAR and class files.

● Generate Classes Only - Toggle the switch to ON to generate only class files for decision tables
and business rules. When set to ON, the EAR file for the project is not generated.

The deployable files are generated at the configured deployable location.

Approving or Rejecting a Commit Request from the Worklist in the New UI
You can approve or reject requests after they are committed to the RMS.
The Dashboard tab displays unresolved artifacts that you can approve or reject. On the Dashboard tab,
you can access the worklist containing the unresolved artifacts from multiple locations as shown in the
following image:

Approving or Rejecting a Commit Request from the Worklist

Item No. Description

1 This icon displays the total number of unresolved items for all projects.

2 User activity timeline displays entry for each unresolved artifact.

3 This icon displays the number of unresolved worklist items for that project.

51

TIBCO BusinessEvents® WebStudio User's Guide



Prerequisites

You should have the permission for the approval action type in the project’s access control file.

Procedure

1. In TIBCO BusinessEvents WebStudio, click the Dashboard tab.

2. On the Dashboard tab, open the worklist of unresolved items in one of the following ways:

● Click the icon specifying the total number of unresolved items on the top of page.

● In the user activities timeline, scroll down to the unresolved artifact entry.

● Click the icon specifying the number of unresolved worklist items on the project card.

3. In the worklist, expand the entry for the commit that you want to approve or reject by clicking its
name for example /Virtual_RF/ProcessApplication (modified) to see the modifications made
to it. For details, see Comparing the Committed and Previous Version of Artifacts in the New UI on
page 53.

4. Click Approve or Reject, depending on the action you want to take for the application changes.

5. Click Finish.

Delegating a Workitem from the Worklist in the New UI
A user with the Administrator role can delegate a workitem to one or more roles. Users belonging to
any of these roles can see the workitem in their worklists.
The Dashboard tab displays unresolved artifacts that you can approve or reject. On the Dashboard tab,
you can access the worklist containing the unresolved artifacts from multiple locations as shown in the
following image:

Delegating a Workitem from the Worklist

Item No. Description

1 This icon displays the total number of unresolved items for all projects.

2 User activity timeline displays entry for each unresolved artifact.
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Item No. Description

3 This icon displays the number of unresolved worklist items for that project.

Prerequisites

Artifacts can be delegated to only those users who have the permission to approve or reject the
committed artifacts.

Procedure

1. In TIBCO BusinessEvents WebStudio, click the Dashboard tab.

2. On the Dashboard tab, open the worklist of unresolved items in one of the following ways:

● Click the icon specifying the total number of unresolved items on the top of page.

● In the user activities timeline, scroll down to the unresolved artifact entry.

● Click the icon specifying the number of unresolved worklist items on the project card.

3. In the worklist, expand the entry for the commit that you want to delegate.

4. Click Delegate.
The Delegate window opens.

5. From the Select Role/s To Delegate To list, select the users to whom you want to delegate the
unresolved artifacts.

6. Confirm the selected roles.

Comparing the Committed and Previous Version of Artifacts in the New UI
Before approving or rejecting a commit request, you can view updates that are made to the committed
version before approving or rejecting the commit request.
The Dashboard tab displays unresolved artifacts that you can approve or reject. On the Dashboard tab,
you can access the worklist containing the unresolved artifacts from multiple locations as shown in the
following image:

Comparing the Committed and Previous Version of Artifacts
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Item No. Description

1 This icon displays the total number of unresolved items for all projects.

2 User activity timeline displays entry for each unresolved artifact.

3 This icon displays the number of unresolved worklist items for that project.

Procedure

1. In TIBCO BusinessEvents WebStudio, click the Dashboard tab.

2. On the Dashboard tab, open the worklist of unresolved items in one of the following ways:

● Click the icon specifying the total number of unresolved items on the top of page.

● In the user activities timeline, scroll down to the unresolved artifact entry.

● Click the icon specifying the number of unresolved worklist items on the project card.

3. In the worklist, expand the entry for the commit that you want to compare.

4. Click the artifact name to view changes made to the artifact.
The updated artifact displays color-coded updates for addition, deletion, and modification. Refer to
the legends displayed on the editor for the significance of each highlighted color.

Deleting Workitems from the Worklist in the New UI
From your worklist, you can delete workitems that are either in the approved or rejected state.
The Recent User Activity timeline shows the workitems that are eligible for deletion. The following
figure shows an example:

Deleting Workitems from the Worklist

Prerequisites

The workitem that you want to delete should be in the approved or rejected status.

Procedure

1. Scroll down to the workitem that you want to delete in the Recent User Activity timeline. If you
want to see its status, expand it.
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You can delete approved workitems also from the project snapshot by clicking the
deployable artifacts icon.

.

2. Click Delete and in the confirmation window, confirm your action.

Deploying an Updated Artifact to the Application from the New UI
After committing edits to an artifact, you can deploy the update to the running application.
On the Dashboard tab, you can access the worklist containing the deployable artifacts from multiple
locations as shown in the following image:

Deploying an Artifact Update to the Application

Item No. Description

1 User activity timeline displays entry for each deployable artifact.

2 This icon displays the number of deployable artifacts for that project.

Prerequisites

Ensure that you have generated deployable files for the project. For details, see Generating the Project
EAR and Class Files in New UI on page 50

Procedure

1. In WebStudio, click the Dashboard tab.

2. On the Dashboard tab, open worklist of deployable items in one of the following ways:

● Click the icon specifying the number of deployable artifacts on the project card.

● In the user activities timeline, scroll down to the deployable artifact entry.

3. In the worklist, expand the entry for the commit that you want to deploy.

4. Click Deploy for the artifact to deploy its changes to the application.

5. On the Deploy Artifact page, select the environment for deployment (for example, QA) and enter
the comment.
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6. Confirm your action.

Viewing Audit Trail of an Artifact or Project
You can view a list of all the actions that were performed on a selected artifact or project using the
Audit Trail option.

Procedure

● You can display the list of actions performed for a project or artifact using either of the following
ways:

● In the Project Artifacts explorer, right-click the supported artifact (decision table and business
rule) or project and select Audit Trail.

The Audit Trail window is displayed. For more details on the fields on the window, see 
Managing Reports on page 77.

● (Artifacts Only) Open the business rule or the decision table for editing. In the editor, click More
Options icon and select Audit Trail.

The Audit Trail window is displayed. For more details on the fields on the window, see 
Managing Reports on page 77.

● You can view the audit trail of artifacts that you want on the Management tab under the
Report Management section. For more details, see Managing Reports on page 77.

Managing Decision Tables
In WebStudio, you can manage existing decision tables of the project or create a new decision table
using the virtual rule function.

Creating a Decision Table
A decision table can only be created using a virtual rule function.

For instructions on adding a VRF, see TIBCO BusinessEvents Developer’s Guide.

Procedure

1. In the Project Explorer, right-click the VRF you want to use and click New Decision Table.
The Create Artifact screen is displayed with the project name in the Project Name field and
Decision Table in the Artifact Type field.

2. On the Create Artifact screen, enter the decision table name in the Artifact Path field and click
Finish.

The new empty decision table is displayed in the work area.

Decision Table Editor Reference
You can create and edit a decision table in WebStudio using the Decision Table editor.

The following sample screen displays a decision table editor in WebStudio and provides brief
description of its elements.
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Decision Table Editor Reference

Elem
ent
No. Element Description

1 Table Title Displays the decision table name
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Elem
ent
No. Element Description

2 More
Options

Lists more options for decision table. The options are:

Delete
Deletes the artifact. Click Confirm on the confirmation screen to delete the
artifact. After deletion commit the changes to the project using the tree
view

Commit
Commits the changes to the artifact for approval. In the Commit Changes
window, enter a comment for the changes in Message text box. Click the
artifact name to review the changes for commit. Click Confirm to commit
the changes to RMS repository.

Synchronize
Synchronizes the update from the server to your local copy of the artifact.
For more details on the fields present on the Synchronize Artifact window,
see Synchronize Artifact Details Window Reference.

Revert
Reverts the update (if not committed) done to an artifact. In the Revert
window, click the artifact name to review the changes to revert. Click
Confirm to revert the changes.

Lock
Locks the artifact for the user and other user cannot commit any changes to
the table until it is unlocked. This option works only if the
ws.scs.locking.enable property is set to true in RMS.cdd.

Rename
Provide a new name to the artifact. After changing the file name, commit
the changes so the artifact is treated as a new artifact.

History
View list of the revisions of the artifact that were committed. For each
revision, you can click View Content to view the revision that was
committed or you can click View Commit to view the revision details.

Audit Trail
Displays the list of actions performed on the artifact by users. You can
refine the results using the filters available in the Audit Trail window. For
more information on the fields, see Management Page Reference.

Export
Exports the artifact to your system. Decision table is exported as a
Microsoft Excel (.xls) file.

3 Save Saves the changes to the decision table locally, but does not commit to RMS
for approval.

4 Commit Commits the changes to the decision table for approval.
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Elem
ent
No. Element Description

5 Validate Validates a decision table, for any access control violations or syntax errors in
the table.

EAR file for the project must be present in the deploy location; otherwise, the
validate command fails.

All the errors are displayed on the Problems tab at the bottom of the editor.
New errors in syntax are added to these existing errors. Double-click errors to
see the problematic view.

6 Undo Reverts last edit done to the decision table.

7 Redo Performs the action again that was reverted using the Undo command.

8 Analyze Opens table analyzer for analyzing the table. For details on table analyzer, see 
Analyzing a Decision Table on page 90.

9 Effective
Date/Time

Specifies the date and time on which the decision table becomes valid in the
runtime application.

10 Expiration
Date/Time

Specifies the date and time after which the decision table is no longer valid in
the runtime application.

11 Priority Sets a priority for the decision table as desired. When a VRF has multiple
implementations (decision tables), the decision table’s Priority setting
determines the order in which the decision tables executes.

12 Single Row
Execution

Set the toggle to ON, if you want the decision table to stop after one row
(rule) passes the condition tests. Only the actions of that row are considered
(until the next time the decision table’s rule function is called).
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Elem
ent
No. Element Description

13 Add
Column

Opens the Add Column window. The fields available in the Add Column
window are:

Custom Type
Toggle the switch to ON to add a custom column or toggle the switch to OFF
to add a regular column.

Select Columns
Select the properties to be added as regular column to the decision table.
You can select multiple fields and they each of those fields is added as
separate column. This field is available only when Custom Type is OFF.

Column Name
Enter the custom condition or action. The custom condition or action can
use the rule language, standard functions, and data in the scope of the
function at run time (for example, scorecards and global variables). It can
also contain complex formulas.

Column Type
Select Condition or Action to add the selected column as condition or
action column.

Property Type
(Read only) Specifies property type of the custom condition or action.

14 Add Row Add an empty row at the end of the decision table. For your convenience, the
newly added row is displayed at the bottom of the selected page of the
decision table. Click Save to save the newly added row and its content.

15 Problems Displays the errors and warnings after decision table validation.

16 Properties Displays the properties for the decision table, cell, and the rule.

● The General tab will contain information about fields like Last Modified,
Version, and Implementation Path.

● The Cell tab will contain information about whether a particular
condition or action cell is enabled or not. You can also add a description
about a cell in the Comments field.

● The Rule tab will contain information about fields Id and Priority. You
can also add a description about the rule in the Comments field.

17 TestData Test data is used for validating decision table. Using test data you can verify
if the decision table covers all the data that might be passed through the
decision table. The test data is not managed in the decision table. The test
data must be in the project in your repository.

18 Errors and
Warning
Icon

The icon displays the number of errors and warnings. Click on the icon to
open the Problems tab.
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Elem
ent
No. Element Description

19 Properties
Icon

Opens the Properties tab.

20 Lock
Indicator

Indicates whether the artifact (decision table) is locked or unlocked.

Exporting a Decision Table
You can export decision tables from TIBCO BusinessEvents WebStudio to Microsoft Excel spreadsheets.

Procedure

1. You can run an export command in either of the following ways:

● Right-click the decision table in the Project Explorer and select Export.
● Open the decision table you want to export. Click the More Options icon in the toolbar and

select Export.

The Save As dialog box is displayed for the exported file.

2. Navigate to the directory in which you want to save the excel (.xls) file and provide a file name.

3. Click Save.

Importing a Decision Table
You can import correctly formatted Microsoft Excel file to create a decision table or to merge to an
existing decision table in TIBCO BusinessEvents WebStudio.

● Only import from the Microsoft Excel files is supported. You cannot import from CSV (comma-
separated values) files or tab-delimited text files. You can open such files in Excel and save as Excel
format binary files.

● Before importing the Microsoft Excel file, ensure that cells are not protected (locked). The protected
cells, after the import, appear disabled in WebStudio.

Procedure

1. Right-click a virtual rule function in the project explorer and select Import.
The Import dialog box is displayed.

2. In the Import dialog box, click Select Files to browse and Open the excel file that you want.
The Name field is automatically populated with the excel file name.

3. In the Name field, you can either provide an existing table name or a new name.

● If table already exists - Select Overwrite or Merge based on your requirement and click
Confirm. If you have selected Overwrite, the decision table with the same name is overwritten.
However, if you have selected Merge, the Synchronize window is displayed where you can
view the modified values for merging and click Confirm. For more details on the elements
present in the window, see Synchronize Artifact Details Window Reference on page 49.

● If table is new - Verify the Parent Folder and click Confirm.
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Creating a Business Rule
A business rule can only be created using a rule template.

For instructions on adding a rule template, see TIBCO BusinessEvents Developer’s Guide.

Prerequisites

Ensure that the All Projects option is selected under the Artifact Groups in the project explorer. Thus,
rule templates are visible in the project explorer.

Procedure

1. In the Project Explorer, right-click the rule template you want to use and click New Business Rule
option.
The Create Artifact window is displayed with the Project Name and Rule Template Instance in
the Artifact Type.

2. In the Create Artifact window, enter the business rule name in the Artifact Path and click Finish.
The Project Name and Artifact Type fields are pre-filled with appropriate values.
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Result

The new business rule is displayed in the work area for editing. The business rule editor depends on
the rule template implementation in the application:

● If the rule template has a rule template view associated with it, an easy to use form is displayed to
specify conditions and actions.

● If the rule template do not have a rule template view associated with it, a builder interface is
displayed to add condition and actions. For details, see the following topics:

— Adding a Conditional Clause by Using the Condition Builder

— Adding an Action Using the Command Builder on page 67

— Business Rule Editor Reference
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Business Rule Example

In the bundled example CreditCardApplication, there are two rule templates: SpecialOffers
and Applicant_PreScreen. The Applicant_PreScreen rule template has a rule template view
(PreScreenTemplateView) associated with it. The PreScreenTemplateView artifact contains
the HTML code for presenting the form based on fields defined in the Applicant_PreScreen
rule template. Thus, when you create a new business rule from the Applicant_PreScreen rule
template, a simple HTML form opens up based on the HTML code defined in
PreScreenTemplateView. However, if you create a business rule from the SpecialOffers rule
template, a builder interface opens up which helps to create more complex rules.

Adding a Conditional Clause by Using the Condition Builder
The When section lets the user define additional conditions that must be met, in addition to the
precondition defined in the rule template.

The builder determines the scope of the rule template and allows you to define individual conditional
clauses based on that scope. Each conditional clause has one or more sub-clause, and a match operator
to determine whether the conditional clause is true based on the sub-clause values.

If you require to move any condition up or down the order then you can drag-and-drop the condition
to move it. Move the mouse pointer over any condition till the pointer is converted to a drag icon. Now,
you can drag that particular condition and drop it within the same or different filter.

Procedure

1. In the business rule editor, under the When section, click the artifact-name link and select the
artifact you require.

2. Click the operator-name link to select another operator, or a child artifact of the previously selected
artifact, as you require. See Business Rule Operators on page 65 for a list of supported operators.

3. Enter the conditional value for the artifact in the empty box.
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4. Click the Add icon  to another condition to the conditional clause, or click the Remove icon to
remove the existing condition from the conditional clause, if you want.

5. Click the Add Sub-clause icon to add a conditional sub-clause to the conditional clause if you want.

6. Click the match-operator link to select the matching condition for which the conditional clause
evaluates to true. The values are:
Option Description

Match Any Conditional clause is true if any of the condition evaluates to true.

Match All Conditional clause is true only if all of the conditions evaluates to true.

Match None Conditional clause is true only if none of the conditions evaluates to true.

7. Click the Save icon to save updates to the business rule.

What to do next

Adding an Action Using the Command Builder on page 67

Business Rule Operators
Business Rule builder operators consists of the conditional clause operators and the action builder
operators. The operator list changes as per the parent entity type in the builder.

Condition Builder Operators

Operator Value on WebStudio
Client Parent Type Operator Value on RMS Server

Matches Other Field
● Concept /

Event

● Data / Time /
Datetime

● Integer / Float

● Text / String

● Boolean

== <field>

Differs From Field
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

● Boolean

!= <field>
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Operator Value on WebStudio
Client Parent Type Operator Value on RMS Server

Is Null
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

== null

Is not Null
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

!= null

Greater Than Integer / Float >

Greater Than Field Integer / Float > <field>

Greater Than Equal To Integer / Float >=

Greater Than Equal To Field Integer / Float >= <field>

Less Than Integer / Float <

Less Than Field Integer / Float < <field>

Less Than Equal To Integer / Float <=

Less Than Equal To Field Integer / Float <= <field>

Equals
● Integer / Float

● Text / String

● Boolean

==

Not Equals
● Integer / Float

● Text / String

● Boolean

!=
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Action Builder Operators

Operator Value on WebStudio
Client Parent Type Operator Value on RMS Server

Set To
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

=

Set To Field
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

● Boolean

= <field>

Set To Null
● Concept /

Event

● Integer / Float

● Text / String

= null

Increment By Integer / Float +=

Increment By Field Integer / Float += <field>

Decrement By Integer / Float -=

Decrement By Field Integer / Float -= <field>

Set To True Boolean = true

Set To False Boolean = false

Adding an Action Using the Command Builder
The Then section defines additional actions to be taken based on the conditions defined.

The builder lets the user define actions based on the statements defined in the actionContext section
of the rule template.

Ensure that all the actions in the business rule are defined and the order should match that of the rule
template. Otherwise, the business rule will be invalid.
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Procedure

1. In the business rule editor, under the Then section, click the Action dropdown list to select the
actions available for the rule template.

2. Click the artifact-name link and select the artifact you want modify.

3. Click the operator-name link and select the command for the artifact. For list of available operators,
see Business Rule Operators.

4. In the text box, enter the value that you want to set for the artifact.

5. Click the Add icon  to add another parameter for the action, or click the Remove icon  to remove the
parameter for action, if you want.

6. Click Save to save updates to the business rule.

Changing Language of the TIBCO BusinessEvents WebStudio New UI
You can change the language of the new user interface in TIBCO BusinessEvents WebStudio from
American English (en_US) to other supported languages.

The following languages are currently supported by TIBCO BusinessEvents new user interface:

● German

● French

● Italian

● Chinese

Procedure

1. Clear the cache for the browser in which you are running TIBCO BusinessEvents WebStudio.

2. Open the browser settings.

3. Choose your preferred language from the list of available languages supported by TIBCO
BusinessEvents WebStudio.

4. Refresh the TIBCO BusinessEvents WebStudio URL.

Business Rule Editor Reference
You can create and edit a business rule in WebStudio using the business rule editor.

The following sample screen displays a business rule editor in WebStudio and the following table
provides brief description of its elements.
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Business Rule Editor Reference

Elem
ent
No. Element Description

1 Table title Displays the business rule name

2 Save Saves the changes to the business rule in cache, but does not commit to RMS.

3 Commit Commits the business rule changes to RMS.

4 Validate Validates a business rule, for any error.

EAR file for the project must be present in the deploy location; otherwise, the
validate command fails.

All the errors are displayed on the Problems tab at the bottom of the editor.
New errors in syntax are added to these existing errors. Double-click errors to
see the problematic view.

5 Undo Reverts last edit done to the business rule.

6 Redo Performs the action again that was reverted using the Undo command.
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Elem
ent
No. Element Description

7 More
options

Lists more options for business rule . The options are:

Delete
Deletes the artifact. Click Confirm on the confirmation screen to delete the
artifact. After deletion commit the changes to the project using the tree
view

Commit
Commits the changes to the artifact for approval. In the Commit Changes
window, enter a comment for the changes in Message text box. Click the
artifact name to review the changes for commit. Click Confirm to commit
the changes to RMS repository.

Synchronize
Synchronizes the update from the server to your local copy of the artifact.
For more details on the fields present on the Synchronize Artifact window,
see Synchronize Artifact Details Window Reference.

Revert
Reverts the update (if not committed) done to an artifact. In the Revert
window, click the artifact name to review the changes to revert. Click
Confirm to revert the changes.

Lock
Locks the artifact for the user and other user cannot commit any changes to
the table until it is unlocked. This option works only if the
ws.scs.locking.enable property is set to true in RMS.cdd.

Rename
Provide a new name to the artifact. After changing the file name, commit
the changes so the artifact is treated as a new artifact.

History
View list of the revisions of the artifact that were committed. For each
revision, you can click View Content to view the revision that was
committed or you can click View Commit to view the revision details.

Audit Trail
Displays the list of actions performed on the artifact by users. You can
refine the results using the filters available in the Audit Trail window. For
more information on the fields, see Management Page Reference.

Export
Exports the artifact to your system. Business rule is exported as
a.ruletemplateinstance file.

8 When
section

The When section lets the user define additional conditions that must be met,
in addition to the precondition defined in the rule template. For more
information, see Adding a Conditional Clause by Using the Condition
Builder.
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Elem
ent
No. Element Description

9 Then
section

The Then section defines additional actions to be taken based on the
conditions defined. For more information, see Adding an Action Using the
Command Builder

10 Problems
tab

Displays the errors and warnings for the business rule after its validation.

11 Properties
tab

Provides the options to set additional description and priority of the business
rule. The Priority property defines the order in which the rules are executed.
The value ranges from 1 to 10, where the lower number specifies higher
priority, for example, the rule with the value 2 have higher priority than the
rule with the value 6.

The default value of the Priority field is 5.

Settings Page Reference
On the Settings page you can change User Settings and Application Settings.

User Settings
This section provides options for personal preferences that you can set for WebStudio. These
preferences are the same as settings that are present on the Preferences tab of the Settings page in the
classic user interface. For more details about these options, see Preferences Settings on page 72.

Applications Settings
Using the Application Settings, you can restrict the operators, and configure project-level email
notifications for each project. This section further categorizes the settings in the following preferences:

● Operator Preferences - Using the Operator section, you can restrict the operators available for
creating the Business Rule using the Builder interface in WebStudio. For more details on these
options, see Operator Settings on page 73 in the WebStudio classic user interface.

● Notification Preferences - Using the notification section, you can configure email notifications
based on the project action. For more details on these options, see Notification Settings on page 74
in the WebStudio classic user interface.

● Deployment Preferences - Using the Deployment Preferences, you can configure hot deployment
settings for the projects without restarting RMS.

These configurations are not applied to the RMS.cdd file but are available only for that
RMS session.

Click the Add icon to add a new hot deployment preferences for a project. Click the Remove icon
to delete an existing deployment preference.

Hot Deployment Configuration Properties

Fields Mapped RMS.cdd Property

Name <ProjectName>.ws.applicableEnvironments

Project Select the project for which hot deployment preferences are configured.
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Fields Mapped RMS.cdd Property

Enable <ProjectName>.<EnvironmentName>.ws.jmx.hotDeploy.enable

Host <ProjectName>.<EnvironmentName>.ws.jmx.host

Port <ProjectName>.<EnvironmentName>.ws.jmx.port

User Name <ProjectName>.<EnvironmentName>.ws.jmx.user

Password <ProjectName>.<EnvironmentName>.ws.jmx.password

Cluster Name <ProjectName>.<EnvironmentName>.ws.jmx.clusterName

Agent Name <ProjectName>.<EnvironmentName>.ws.jmx.agentName

InMemory <ProjectName>.<EnvironmentName>.ws.jmx.inMemory

For more information on the hot deployment settings present in the CDD file, see Hot Deployment
Property Group on page 32.

Preferences Settings
Set preferences for TIBCO BusinessEvents WebStudio using the options available on the Personal
Preferences tab.

After updating the values, click Apply to set new WebStudio preferences.

Field Default Value Description

Number of
Recently
Opened Items

10 The number of recently open items to be displayed in the Recently
Opened dashboard portlet.

Default URL
for Custom
Webpage

www.tibco.com (Classic user interface only) The default URL for the Web Page
dashboard portlet

SCS User
Name

jdoe The username to connect to the SVN repository mentioned in the
ws.scs.rootURL property of the RMS.cdd file. This user name
overrides the default username provided in the
ws.scs.default.username property of the RMS.cdd file.

See Source Control System (SCS) Property Group for more details
on the RMS.cdd properties.

SCS User
Password

jdoe The password for the SCS User Name field to connect to the SVN
repository mentioned in the ws.scs.rootURL property of the
RMS.cdd file. This password overrides the default password
provided in the ws.scs.default.password property of the
RMS.cdd file.

See Source Control System (SCS) Property Group for more details
on the RMS.cdd properties.

Unlike the ws.scs.default.password property of the RMS.cdd
file, this field takes the actual password and not the Base64
formatted password.
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Field Default Value Description

View Project
as

List The structural view of the project artifacts under the Group Content
in workspace and in Dashboard Portlets.

Decision
Table Page
Size

20 The number of rows of the decision table to be displayed in a page.
Reopen the decision table, or disable and then again enable the
page view, to reflect the updated page size for the decision table.
The minimum page size is limited to 10.

Default Rule
Template
Instance Filter

Match Any Specifies the default logical operator for new conditions in the
condition builder of the business rule.

Select widget
for string
bindings in
Rule Template
Instance

TextArea Choose between TextBox and TextArea for string bindings in rule
template instances. To enter multiple-line values, select the
TextArea option.The setting is applicable across all rule template
instances in all the projects.

You can use TIBCO BusinessEvents Studio to set the binding values
in rule template instances of a particular project. For the string
binding that you want, in the binding element, set an attribute with
widgetType key and value TextBox or TextArea.

Auto UnLock
on Approve/
Reject

selected If selected, the property enables the artifact to be unlocked once
they are either approved or rejected for the committed update.

Group
Related
Artifacts

selected If selected the business rules are grouped under their parent rule
templates, and decision tables are grouped under their parent
virtual rule function. If the check box is clear, the decision table and
rule templates are not grouped and are listed individually.

Allow Custom
Domain
Values

selected If selected, the custom values can be entered for the attributes
associated to the domain. If the check box is cleared, you can only
select from the domain values list using the drop-down.

Show column
alias if
present

cleared If selected then column alias are displayed for the decision table
columns. Column alias can be defined using the column option
Field Settings.

Columns Auto
Fit Approach

Default (Classic user interface only) Specifies the autofit approach for the
columns of decision tables. Select the required value and click
Apply. Refresh the decision table for the new autofit approach to
take effect.

● Default - Default column width

● Both - Resizes all columns to autofit the column heading as well
as the column values

● Title - Resizes all columns to autofit the column heading

● Value - Resizes all columns to autofit the column values

Operator Settings
Using the Operator Preferences, you can restrict the operators available for creating business rules
using the Builder interface in the TIBCO BusinessEvents WebStudio.

The Operator Preferences section consists of three columns.
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Preference Description

Field Type Lists the type of the fields available in the
condition and command builder. Select the field
type for which you want to restrict the available
operators. The available field types are:

● String

● Integer

● Long

● Double

● Boolean

● DateTime

● Concept/Event

Filter Operators Lists the operators available for the selected
Field Type in the condition (When) builder.

Select the operators that you want to display in
the condition builder for the selected Field Type
and click Apply.

The operator with a clear checkbox does not
appear in the Builder interface while creating a
conditional clause for the business rule.

Command Operators Lists the operators available in the command
(Then) builder for the selected Field Type.

Select the operators that you want to display in
the command builder for the selected Field Type
and click Apply.

The operator with the clear checkbox does not
appear in the Builder interface while defining
actions for the Business Rule.

Notification Settings
Using the Notification Preferences, you can configure email notifications based on the project action.

Projects
All the projects in the rule management server are listed under this column. You can configure email
notifications for each project.

Actions
You can select the actions for which you want to send email notification for the selected project. The
Apply button becomes active if there are any changes in the actions for the project. Click Apply to
apply all the email notification configurations.

Email ID
You can add, edit, or delete email IDs to which you want to send notifications for the project actions.
Click the Add or Delete icon to add or delete an email ID. The Apply button becomes active if there
are any changes in the email list for the project. Click Apply to apply all the email notification
configurations.
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Managing Users
A user with an administrator role can add users, delete users, change passwords for users, and edit
user roles.

Procedure

1. In the TIBCO BusinessEvents WebStudio, select the Management tab.

2. Select Users under the Permission Management menu.

3. To add users, delete users, change user passwords, and edit user roles, perform the relevant steps:

Purpose Steps

Creating a user
1. Click the Create User icon.

2. In the Add User window, fill in the following fields:

● Username

● Password

● Confirm password

● Assign Role to User

3. Confirm your actions.

Deleting a user
1. Select the user you want to delete.

2. Click the Delete User icon.

Changing user
password 1. Select the user whose password you want to change.

2. Click the Change Password icon.

3. In the Change Password window, enter the new password and confirm
it.

4. Confirm your actions.

Editing user
roles 1. Select the user whose roles you want to edit.

2. In the Roles section, based on your requirement, select or clear actions
for the selected user.

4. Click Apply.
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Managing Roles
Users with the administrator role can add, edit, or delete roles for the projects present in the TIBCO
BusinessEvents WebStudio. They can also define the actions that a user with a particular role can
perform on the different types of artifacts.

Procedure

1. In the TIBCO BusinessEvents WebStudio, select the Management tab.

2. Select Roles under the Permission Management menu.

3. Perform an action based on your requirement:

Purpose Steps

Adding roles to a
project 1. On the Roles section, click the Add role to the project icon.

2. Enter the name for the new role.

3. Confirm your action.

Removing roles from a
project 1. Click the Remove role from project icon.

Defining actions that
can be performed by
user roles

You can change artifact-specific permissions for roles in specific
projects.

1. From the Projects section, select the project for which you want to
edit the role permissions.

2. From the Roles section, select the role for which you want to edit
the permissions.

3. In the Actions section, based on your requirement, select or clear
actions for a user role.

Managing Locks
Users with administrator roles can release artifacts locked by other users. For example, when the user
who has locked the artifact is not available and the artifact needs to be updated, the administrator can
make the artifact available for an update.

Prerequisites

Locking must be enabled by setting the ws.scs.locking.enable property to true in the CDD file.

Procedure

1. In the TIBCO BusinessEvents WebStudio, select the Management tab.

2. From the Permission Management pane, select Locks.

3. In the Projects section, select the project whose artifacts you want to release.

4. From the List of Locked Artifacts section, select the artifact you want to release.

5. From the Artifact Details section, clear the Lock checkbox and click Apply.
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Managing Reports
Users with administrator roles can generate reports on user activities

Procedure

1. In the TIBCO BusinessEvents WebStudio, select the Management tab.

2. Select Audit Trail under the Report Management menu.

3. Apply filters that you want from the following:

Field Description

Project Select the project for which you want to see the
actions performed

Artifact Enter the full name of the artifact along with
its path to view audit trail for that artifact. For
example, enter /Virtual_RF/Applicant to
display results for actions performed on the
Applicant decision table.

Action Types Select the type of actions for which you want
to see the audit trail.

After Date Select the date and time to display actions that
were performed after the selected data and
time.

Before Date Select the date and time to display only those
actions that were performed before the
selected data and time.

LogFile Select the LogFile check box to save the results
in a log file instead of displaying the results on
the screen.

4. To save the filters and generate a report, click Apply.
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WebStudio Classic User Interface

The classic user interface provides complete WebStudio functionality in the old familiar user interface.

● TIBCO BusinessEvents WebStudio classic UI is deprecated in this release. You must use TIBCO
WebStudio new UI, with enhanced user experience and features, for managing business rules.

● The WebStudio classic user interface supports Mozilla Firefox web browser till version 62.

RMS Projects and Artifacts
The projects and artifacts that were added to RMS can be used in WebStudio to create business rules.

Starting and Logging in to RMS
Before you can work on the RMS projects, you need to start and log in to the RMS.

Procedure

1. Start the RMS server by using one of the following ways:

● Run BE_HOME/rms/bin/be-rms.exe (or be-rms.sh, depending on your operating system),
with valid arguments. For example, on Windows you would open a command window in
BE_HOME/rms/bin and execute:
   be-rms.exe

● (Windows only) Select Start > All Programs > TIBCO > TIBCO_HOME > TIBCO
BusinessEvents <version> > Start Rules Management Server.

The server is ready when you see a message in the command window such as:
Info [HTTP-Channel-Startup] - [driver.http] Channel server for HTTP Channel 
[Port:5000] successfully started

2. Type the URL http://host:port/WebStudio/ in a web browser. Default host is localhost and default
port is 8090. Host and port are configurable using properties in RMS.cdd. Ensure that the RMS is
running before logging to TIBCO BusinessEvents WebStudio.

3. To use the classic user interface, click Switch to Classic View.

4. Type the username and password for TIBCO BusinessEvents WebStudio.

5. Click Login to sign in to RMS.

Result

The application displays the TIBCO BusinessEvents WebStudio dashboard.

The system restricts multiple simultaneous login of the same user name. However, if you have previous
unclosed sessions of the same username you can select the Force Login check box to close all the other
sessions of the user. The check box is only visible if multiple login for the user is detected.

In TIBCO BusinessEvents WebStudio, click Sign out to log out. In the case of session timeout, the user
is automatically logged out.

Status Check for RMS Connection

Once a TIBCO BusinessEvents Studio, a TIBCO BusinessEvents Decision Manager, or a TIBCO
BusinessEvents WebStudio client logs in to RMS, a Dashboard background activity periodically polls
the RMS server to refresh the worklist items in WebStudio and rms.heartbeat.relay property (in
studio.tra) is used by Studio to configure the heartbeat time.

By default, the delay is of two seconds.
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If the server goes down, the menu options for RMS are automatically disabled. However, if you are
already performing an RMS operation and the server goes down, the operation fails. The login option is
enabled when the server comes up again.

Checking Out a Project
If RMS is used in your environment, then you must log into RMS and check out a project from RMS
before you can work with the project resources in the TIBCO BusinessEvents WebStudio UI.

When generating an EAR file using the Generate Deployable option, the project resources from the
RMS repository and not from the workspace are used.

Depending on your role or roles, you may not have permission to check out all resources or to do all of
the documented tasks. For instructions on updating a project you already checked out, see Updating
(Synchronizing) a Project.

The checkout dialog does not list the imported 4.x release projects, if the project name contains a dot(.).
These imported projects should be renamed inside TIBCO BusinessEvents Studio to remove the dot(.)
from the project name.

Procedure

1. Open the checkout window using any of the following methods:

● In the Dashboard tab, click the link in the My Projects section if no projects are checked out.

● In the My Workspace tab, click WebStudio, with the down-pointing triangle in front of it, and
select RMS > Checkout .

● In the My Workspace tab, right-click inside the Group Contents section and select RMS >
Checkout .

● In the My Workspace tab, click the checkout icon  in the RMS toolbar.

2. In the checkout window, select the project you want to check out from the Project List drop-down.

3. Select the check boxes of the files you want to check out and click OK. Alternatively, select the
header checkbox to select all the files for check out and click OK.

You can perform partial checkouts as per your requirement, such as, check out some files
in the start and then later on check out more files as required.

Result

In TIBCO BusinessEvents WebStudio the checked out project is displayed under Group Contents and
the project files are loaded to your workspace. The Group Contents section displays the artifacts based
on the groups (Projects/Business Rules/Decision Tables/Process) selected in the Groups section. The
Business Rules, Processes and the Decision Tables group are selected by default after you check out a
project. In the Group Content tab, business rules are displayed under their parent rule templates and
decision tables are displayed under their parent virtual rule functions.

The TIBCO BusinessEvents WebStudio displays the project files in the Group Contents section either as
a list or in a tree structure. In the Group Contents section click the project view icon to select the Show
items as tree or Show items as list option to toggle between the tree view ( )and the list view ( ). The
list view is the default view.
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Updating (Synchronizing) a Project
After you log into the RMS server, and it is recommended that you update (synchronize) your local
copy of the project, with the most recent changes from the RMS server, before continuing to work on it.

Other users may have checked in changes, additions, and deletions that are now available for check out.
There may be other changes too. You can select what updates to accept. Changes and additions to
individual decision tables and business rules are listed.

Procedure

1. In the Group Contents section, select the artifact you need to synchronize.

The synchronize command does not support multiple artifact selection using Shift or Ctrl
key. Alternatively, select a folder/project to select all artifacts under that folder/project,
when project files are displayed in a tree structure.

2. Open the synchronize window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS >
Synchronize .

● Right-click on the selected artifact and then select RMS > Synchronize .

● Click the synchronize icon  in the RMS toolbar.

3. If there are local changes as well as the server-side changes, then WebStudio highlights the
conflicted artifacts. Double-click on the artifact to see the changes. Right-click on the artifact and
select Use Local to use your copy of the artifact, or select Use Base to use the copy on the server.

4. Select the check boxes of the files you want to synchronize and click OK. Alternatively, select the
header checkbox to synchronize all the listed project files and click OK.
If there are some local changes for the artifact and then you can double-click the artifact to view the
highlighted server-side change. Hover the mouse over the highlighted (conflicted) field to see the
server-side value. Right-click on the conflict field and select Use Local to use your copy of the
artifact, or select Use Base to use the copy on the server and discard the local changes.
The selected artifacts are updated with the latest project files from RMS.

Synchronizing Artifacts Changes into RMS
In WebStudio you can synchronize the project artifacts changes, that you have made externally after
performing check out in WebStudio, into RMS.
Using the Sync To Repository function, you can synchronize artifacts which cannot be managed in
WebStudio. The project artifacts which can be synchronized are:

● Concepts

● Events

● Virtual rule function

● Rule template.

During synchronization, only additive changes are synchronized to existing WebStudio managed
entities, which are referencing those changed artifacts. The changes related to deletion are not
synchronized. After synchronization, you should use the Validate function to identify the entities
which are affected by the deletion changes. The WebStudio managed entities are:

● Decision table

● Business rule
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● Process.

Procedure

1. Open the synchronize window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Sync To
Repository.

● In the Group Contents section, right-click anywhere and select RMS > Sync To Repository.

The Sync To Repository window is displayed.

2. In the Sync To Repository window, select the project that you want to synchronize from Project List.
All the artifacts of the allowed types for the selected project are listed.

3. Select the artifacts that you want to sync to RMS and click OK.

Locking an Artifact
An exclusive lock ensures that while you are modifying the artifact, no other user is able to edit or
delete it.
When other user tries to save the edit done to the locked artifact, or lock the locked artifact, WebStudio
displays an error stating that the artifact is already locked by a user.

Prerequisites

Enable the artifact locking mechanism for WebStudio using the ws.scs.locking.enable property in
the RMS.cdd file. See Source Control System (SCS) Property Group for more details.

Procedure

● In the Group Contents section, right-click on the artifact you need to lock, and select RMS > Lock .
The artifact is locked and a lock is displayed on the artifact icon.

Unlocking a Locked Artifact
Release the locks on the artifact after completing work on the artifact, so that other users can also work
on the artifact.
Alternatively, you can also select the Auto UnLock on Approve/Reject property check box to release
the lock on the artifact as soon as the commit on the artifact is approved or rejected. The property can
be set in the Preference portlet under the Settings tab in the WebStudio UI. See Preferences Settings for
more details.

You can also set up a timeout for locks using the ws.scs.lock.timeout property in RMS.cdd, after
which the locks are released. See Source Control System (SCS) Property Group for more details.

Procedure

● In the Group Contents section, right-click on the locked artifact you need to unlock, and select RMS
> UnLock .
The artifact is unlocked now and the lock disappears from the artifact icon.

Managing Locks on Artifacts
Administrators sometimes need to release locks, established by other users. For example, when other
user is not available and the locked artifact is needed for some other updates.
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Prerequisites

The user who is managing the lock should have the ALLOW permission set for the manage_locks action
for the project in the RMS project's access control file. See the TIBCO BusinessEvents® Administration
guide for more details on how to configure the access control file.

Procedure

1. Open the Manage Locks window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Manage

Locks .

● In the Group Contents section, right-click any artifact and select RMS > Manage Locks .

The Manage Locks window is displayed.

2. Select the project from the Project List dropdown.
The Manage Locks window displays all the locked artifacts by all users for the project.

3. Select the check boxes for the artifact for which you must release the lock and click UnLock.
All the selected artifacts are now unlocked and can be updated by all users.

Committing Artifacts for Approval
After you complete the additions, changes, or deletions to a project you checked out of RMS, commit
the artifacts for approval. You can make a commit request for a selection of artifacts, or all.

Copies of submitted artifacts are saved in cache, with the names of the users who submitted them,
version numbers, and the status Committed. A task is created for the Approver role to review the check-
in requests. (see Working with the Worklist Items).

A Revision ID is assigned to each commit request. This ID is used in other dialogs to allow you to view
the details on the request.

If the project is checked out from the SCS repository, then, similar to the file mode, the committed
artifacts are saved in the local cache, till the approval. After the approval, the committed artifacts from
the cache are saved to the local repository, identified by the value of the ws.scs.repo.dir property in
RMS.cdd (see Configuring RMS Server Properties), and checked in to the SVN repository as well. The
comments entered for commit are used as check-in comments for the SVN repository, after approval.

Procedure

1. In the Group Contents section, select the artifact you need to commit.

Commit command does not support multiple artifact selection using the Shift or Ctrl key.
Alternatively, select a folder/project to select all the artifacts under that folder/project,
when the project files are displayed in a tree structure.

2. Open the commit window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Commit .

● Right-click on the selected artifact and select RMS > Commit .

● Click the commit icon  in the RMS toolbar.

3. In the Commit window enter the revision description in the Comments text box.

Comments field is not a mandatory field but it is recommended to comments before committing.
This helps the approver to understand the nature of changes.
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4. Click the check boxes for the files you want to commit to the RMS project and click OK.
Alternatively, click the header checkbox to select all the listed project files.

5. Click Finish after the system displays the check-in successful message with the revision ID.

Reverting Artifact's Update
The Revert command can revert the updates done to an artifact in the WebStudio and restore it to a
previous version.
The Revert command also reverses the Delete command. It can reverse the update to the following
artifacts:

● Decision Tables

● Business Rules

● Processes

● Domain Models

The Revert command restores the artifact to the last version that was committed in the repository. If
multiple changes are made to the artifact and no commit is done to the repository, the Revert command
reverses all the changes. This command does not work on the changes which are committed to the
repository. Thus, ensure that the updates, which you are sure of, are committed to the repository on a
regular basis. Also ensure that the Revert command is used only on the updates, of which you are
unsure.

You can make a revert request for one or for a selection of artifacts.

Procedure

1. In BusinessEvents WebStudio, open the Revert window using one of the following ways:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Revert .
● Right-click the selected artifact and select RMS > Revert .
● Click the Revert icon in the RMS toolbar.

2. Select the check boxes for the artifacts for which you want to revert the updates and click OK.
Alternatively, select the header check box to select all the listed artifacts.

3. Click Finish after the system displays the "revert successful" message with the revision ID.

Result

The artifact is reverted to its previous version, which was last committed to the repository.

Viewing History of an Artifact
You could view the update performed in earlier revisions of the artifact, and also view the update
performed to other artifacts in the those revisions.

Procedure

1. In the Group Contents section, right-click the artifact, of which you want to view revision history,
and select RMS > Show History .

2. The History window displays all the previous revisions of the artifact. Use the following search
options and click Go to filter the results:
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Option Description

From Select the from date using the date picker. Only revisions which are committed on or
after this date are displayed.

To Select the to date using the date picker. Only revisions which are committed on or before
this date are displayed.

Search Type the keyword to perform search in the user-name and comments fields.

3. In the Revisions panel, select the revision of which you want to view the details. See Revisions
Panel Reference for more details on the Revisions panel columns.

A detailed list of all updated artifacts for the selected revision is displayed in the Details panel with
the artifact of interest in bold. See Details Panel Reference for more details on the Details panel
columns.

4. In the Details panel, right-click the artifact and select Diff with Previous Version to view the
update made to the artifact in the selected revision from the previous approved revision.

The updates on the updated artifact are displayed highlighted in different colors for addition,
deletion, and modification. Refer to the legend displayed on the editor for the significance of each
highlighted color. Hover the mouse pointer over the highlighted (modified) part to see the previous
value.

The History window is minimized while the version difference for the artifact is displayed. Click
the Restore Window icon of the minimized History window to restore it.

5. Finally, click Close to close the History window.

History Window Reference
The history window lists the revisions for the selected artifact in the Revision panel and details of the
selected revision in the Details panel.

Revisions Panel Reference

The revision panel lists revisions associated with the selected artifact. The list can be filtered using the
search options in the History window.

Column Description

Revision The unique ID assigned to each revision by WebStudio.

User Name The user name of the user who had performed the commit.

Date The RMS system date and time of the commit. Format of Date is DD/MM/YYYY
HH:MM. For example, 06/08/2013 14:35.

Comments The comments provided by the user at the time of the commit.
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Details Panel Reference

The Details panel displays the list of artifacts committed in the selected revision. The panel also lists
various details about the artifacts update specific to that revision. You can also view the differences
between the selected revision of the artifact and its previous approved version.

Column Description

Action The update action performed on the artifact.

The values are:

● Create

● Modify

● Delete

Type The icon identifying the type of artifact, whether business rule or decision table.

Path The location of the artifact with respect to the project’s root directory.

File type The file extension of the artifact.

The values are:

● ruletemplateinstance (for Business Rules)

● rulefunctionimpl (for Decision Tables)

Approval Status The approval status of the artifact for the revision. See Approval Status Values
for more details on approval status values.

The values are:

● Committed

● Approve

● Reject

● BuildAndDeploy

Removing a Project from Workspace
You can remove the project from the WebStudio workspace after completing work on the project.

The project could be removed either from the My Workspace tab, where all its artifacts are displayed,
or from the Dashboard tab, where all open projects are listed under the My Projects dashboard portlet.

Removing a Project from Workspace Using the My Workspace Tab

The My Workspace tab displays the checked-out project resources.

Procedure

1. In the My Workspace tab, under the Group Content section, click the Change View icon and select
Show items as a tree (if not already selected).
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The project artifacts are now displayed in the tree structure.

2. Right-click the project name and select Delete or click on the Delete icon in the toolbar.

The Confirm window is displayed to confirm project deletion.

3. Click OK to remove the project from the WebStudio workspace.

Removing a Project from Workspace Using the Dashboard Tab

You can remove the project from the workspace using the Dashboard tab.

Procedure

1. In the Dashboard tab, under the My Projects dashboard portlet, click the Delete icon in front of the
project name.

The Confirm window is displayed to confirm project deletion.

2. Click OK to remove the project from the WebStudio workspace.

Validating Multiple Artifacts of a Project
You can save time and effort by validating multiple decision tables and business rules of an RMS
project at the project level.
In TIBCO BusinessEvents WebStudio, validate the artifacts, for any access control violations or syntax
errors, using the validate command.

Procedure

1. In the My Workspace tab, under the Group Content section, click the Change View icon and select

Show items as a tree  (if not already selected).
The project artifacts are now displayed in the tree structure.

2. Select the project and click the Validate icon  to validate multiple decision tables and business
rules of the project.
All the errors are displayed in the Problems View tab at the bottom of the application.

3. Double-click errors to see the problematic view.
Take any needed corrective actions and then validate the artifacts again until all errors are resolved.

Deleting Errors and Warnings
After validation, when there are many errors and warnings in the Problems View tab, delete obsolete
warnings and errors, so that you can browse the errors easily.

Procedure

● In the Problems View tab, right-click the obsolete warning or errors and select Delete.
The selected error or warning is now deleted from the tab.
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Keyboard Shortcuts
Keyboard shortcuts can make it easier to interact with TIBCO BusinessEvents WebStudio, saving you
time and effort as you work with RMS projects in WebStudio.

Keyboard Shortcuts in WebStudio

Command Keyboard Shortcut

Shift+Alt+K Check out

Shift+Alt+P Commit

Shift+Alt+R Revert

Shift+Alt+W WorkList

Shift+Alt+G Generate Deployable

Shift+Alt+J Validate

Shift+Alt+O Export

Shift+Alt+U Import

Shift+Alt+L Sync

Managing Decision Tables
In WebStudio, you can manage existing decision tables of the project or create a new decision table
using the virtual rule function.

Creating a Decision Table
A decision table can only be created using a virtual rule function (VRF).

For instructions on adding a VRF, see TIBCO BusinessEvents Developer’s Guide.

Procedure

1. Select the Projects group.

2. In the Group Contents section, right click the virtual rule function (VRF) you want to use and click
New Decision Table.

3. Enter the decision table name in the Decision Table pop-up window and click OK.
If needed, you can enter a new folder name in the Parent Folder field and the new folder is created
in the project.

The new empty decision table is displayed in the work area.

Deleting a Decision Table
You can remove a newly added table as well as any existing table from the project.

If the table you want to delete has been checked into the RMS project, then you must submit the
deletion for approval. After approval, the deleted table is removed from the RMS project.
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Procedure

1. Do one of the following:

● In Group Contents, right-click the decision table name and select Delete.

● In Group Contents, select the decision table name. Then click the Delete icon  in the Edit
toolbar.

2. If the table has been committed to the RMS project, select one of the following options as
appropriate:

● Commit the project or the parent folder so that the RMS master copy of the table is also
deleted.

● Synchronize the project to replace the deleted copy with the RMS project version of the table.

What to do next

In order to delete the decision table classes, after approving the deletion of decision table, select the
BuildAndDeploy status of worklist for the deleted decision table. See Generating and Deploying the
Decision Table’s Class File for more details on how to generate decision table classes.

Renaming a Decision Table
You can rename a decision table in WebStudio to a more suited name, which identifies its functionality
more appropriately.

Procedure

1. In Group Contents, right-click the decision table name and select Rename.

A decision table name can contain letters, numbers, and underscore only. It should start
with a letter and be less than 64 characters.

WebStudio displays the Rename completely successful message.

2. If the table has been committed to the RMS project, commit the project or the parent folder so that
the RMS master copy of the table is also renamed.
The changes appear in two entries: one with the Change Type as Added and other with the Change
Type as Removed in the Commit window and the Worklist window. Commit both the entries
together as a single commit; otherwise WebStudio displays an error.

Setting the Decision Table Properties
In the Group Contents section, double-click the decision table you want to open. You can now edit,
analyze, and export the open decision table.

Procedure

1. In the decision table work area, click the Properties icon .
The Properties view is displayed at the bottom of the work area.
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2. Edit the following fields to set the Decision table properties.
Option Description

Effective Date Define the date and time on which the decision table becomes valid in the
runtime application. Click the Calendar icon and use the Calendar dialog to set
the date, and then edit the time as needed.

Expiry Date Define the date and time after which the decision table is no longer valid in the
runtime application.

Take Actions of
One Row at
Most

Select the check box, if you want the decision table to stop after one row (rule)
passes the condition tests. Only the actions of that row are considered (until the
next time the decision table’s rule function is called).

Priority Set a priority as desired. When a VRF has multiple implementations (decision
tables), the decision table’s Priority setting determines the order in which the
decision tables executes.

3. Click the Save icon  in the Edit toolbar to save the changes to the decision table.

Result

The decision table is still open for you to edit and the changes are not applied to RMS unless you
commit the changes to RMS.

Enabling or Disabling the Page View
When a large table is displayed in multiple pages, it improves the server response time as well as a
better user experience.

A decision table is displayed in pages if the number of rows are more than the value specified for the
page size (minimum is 10 and default is 20). The page size can be specified in the following locations:

● The tibco.clientVar.Webstudio/DecisionTable/pageSize property in the RMS.cdd file. See 
Configuring RMS Server Properties on how to configure the RMS properties.

● The Decision Table Page Size field in the Preference portlet under the Settings tab in the
WebStudio UI. See Preferences Settings for more details.

Procedure

1. In the decision table editor, click Show All to disable the page view for the decision table and
display all rows.

2. Click Show Pages to return to the page view for the decision table.

The option appears in place of navigation options after clicking the Show All option.
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Result

Navigate through the pages using navigation options present at the bottom of the decision table. Click
on the specific page number to open that page or click Previous and Next options to navigate through
pages sequentially.

Analyzing a Decision Table
In the Table Analyzer you can set example condition values and perform various validation checks on
the currently displayed decision table.

Table analyzer supports the Not Equal To (!=) operator.

Procedure

1. In BusinessEvents WebStudio open the decision table you want to analyze.

2. Click the Decision Table Analyzer icon  to view Table Analyzer.

3. In the Table Analyzer section, controls are created dynamically for setting values and ranges for
each condition in the table. Enter or select the example values for which you want to analyze the
table.
For example, if the condition is a range, for instance “< 40” or “> 10 && < 100”, then the
corresponding control in the Table Analyzer section is a Slider that spans the range from the
minimum value to the maximum value. You can then select a range of values within the range.

4. Click the Analyze icon  to analyze the decision table based on the selected values.
A pop-up window displays the count of any issues. The Problems section at the bottom displays
more information on issues. Click the issue to highlight the row.

5. You can click the Show Coverage icon  in the table analyzer section to highlight all rows that meet
the criteria. In page view, browse through the pages to see the highlighted rows.
For example, if you select Male for Gender; true for Eligible; and 50000-60000 for Income,
clicking Show Coverage displays all rows that have Male, true, and an income between 50000 and
60000.

Validating a Decision Table
In TIBCO BusinessEvents WebStudio, validate a decision table, for any access control violations or
syntax errors in the table, using the validate command.

The Validate icon is activated when the decision table is opened in the editor. EAR file for the project
should be present in the deploy location; otherwise, the validate command fails. If the EAR file is not
present at the deploy location, then you receive the following error while validating the decision table:
EAR for projects: <project_name> either not present or not in sync at deploy 
location.

Procedure

1. Select the decision table and click the Validate icon to validate the table.
All the errors are displayed in the Problems View tab at the bottom of the application. New errors
in syntax are added to these existing errors.

2. Double-click errors to see the problematic view.

Take any needed corrective actions and then validate the table again until all errors are resolved.
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Validating a Decision Table Using Test Data
Using test data you can verify if the decision table covers all the data that might be passed through the
decision table. This enables you to add more rules to the decision table, if the decision table is not able
to cover the test data.

Prerequisites

Create the test data for at least one argument from BusinessEvents Studio. See TIBCO BusinessEvents
Developer's Guide for more information on creation of test data. The test data must be in the project in
your repository.

The test data are not managed in the RMS repository.

Procedure

1. In the Table Analyzer, click the Check Test Data Coverage icon .

You can select the test data for only a single argument at a time.

The Check Test Data Coverage window is displayed with the available test data.

2. Select the test data, for which you want to validate the decision table and click OK.
The table analyzer validates the decision table based on the test data and displays the Test Data
Coverage tab at the bottom pane. The Test Data Coverage pane highlights the rows of test data,
which are covered in the decision table.

Exporting a Decision Table
You can export decision tables from TIBCO BusinessEvents WebStudio to Microsoft Excel spreadsheets.

Procedure

1. Open the decision table you want to export.

2. Execute the export command in either of the following ways:

● Click the Export icon  in the Tools toolbar. You see the Save As dialog box for the exported
file.

● Right-click the decision table in the Group Contents section and select Export.

3. Browse to the directory in which you want to save the excel file and provide a file name.

4. Click Save.
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For example, a sample exported Microsoft Excel Sheet is given the following figure.

Importing a Decision Table
You can import correctly formatted Microsoft Excel file to create a decision table or to merge to an
existing decision table in TIBCO BusinessEvents WebStudio.

● Only import from the Microsoft Excel files is supported. You cannot import from CSV (comma-
separated values) files or tab-delimited text files. You can open such files in Excel and save as Excel
format binary files.

● Before importing the Microsoft Excel file, ensure that cells are not protected (locked). The protected
cells, after the import, appear disabled in WebStudio.
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Importing a Decision Table Flowchart

Procedure

1. Open the Import dialog box in either of the following ways:

93

TIBCO BusinessEvents® WebStudio User's Guide



● Select the virtual rule function and click the Import icon  in the Tools toolbar.

● Right-click the virtual rule function in the Group Contents section and select Import.

2. Click Choose Files in the Import Decision Table dialog box.

3. Browse the excel file you want to import and click Open.

4. In the Name field, do either of the following:

● Specify the new decision table name and click OK.

● Specify the name of an existing decision table name and click OK.

Depending on the decision table name, either a new decision table is created or a prompt is
displayed that a decision table with the existing name already exists. The prompt provides the
option to either overwrite existing table or merge the imported and the existing table.

5. If you have given an existing decision table name, in the prompt, select either of the following
options and click OK.
Option Description

Overwrite the existing
decision table

The imported table overwrites the existing decision table with the same
name.

Manually merge the
imported decision table
with the existing one,
in a diff editor

WebStudio automatically merges both the decision tables and displays
the merged decision table in the decision table editor. All the differences
are highlighted using the following legends:

● Green for added items

● Red for deleted items

● Yellow for modified items

In the editor, to restore any data to the local value, click the modified
item and select Use Local. Click the Save icon to save the changes to the
decision table.

Adding Condition and Action Columns from Arguments
Add the condition and action columns using the arguments under the virtual rule function scope.

Procedure

1. Open the decision table you want to edit.

2. In the Group Contents section, right-click the decision table and select Show Arguments.

A plus icon is displayed in front of the decision table for argument list expansion.

3. Click the plus icon to expand the arguments list. If needed, click the plus icons for concepts and
rules as well.

The decision table arguments are listed under the decision table.

4. Drag a property from the argument list to the decision table editor.

A Create Column pop-up window appears to create the condition or action column.
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5. Click the Condition or Action radio button and click OK to create a Condition or Action column.
A new Condition or Action column is added at the end of the Condition or Action column-sets
respectively.

Adding Custom Condition and Action Columns
Add the condition and action columns using the rule language, standard functions, and data in the
scope of the function at runtime (for example, scorecards and global variables).

Procedure

1. Open the decision table you want to edit.

2. Click Custom in the decision table editor menu and select either of the following options:

● Select Add a custom Condition to insert a custom condition column at the end of condition
column set.

● Select Add a custom Action to insert a custom action column at the end of action column set.

Defining Custom Columns Using Substitution
You can specify complex entries in a column by using column substitution. This feature works where
all the entries in a column follow a specific pattern.

As an example, suppose all entries in a column use a comparison such as this, but with different values
in each case:
Math.maxInt(MyAlias.Value, MyAlias.MaxValue) < 50

Instead of typing such entries in each cell, you could use substitution.

Procedure

1. In the column header, specify (right-click the column and select Field Settings) the pattern:
Math.maxInt({0}, {1}) < {2}

2. In each of the column cells, specify parameter values, using a semicolon delimiter:

MyAlias.Value; MyAlias.MaxValue; 50

3. Press Enter so that the cell contents are substituted with the pattern of the column name.
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Setting Default Value in Decision Table Column
Using the Field Settings option of the column, you can set a default expression for the column for all
new rules.

Procedure

1. Open the column's options menu by either of the following ways:

● Right-click any one of the column headers.

● Hover the mouse pointer over any one of the column headers to view the down-pointing
triangle and click the triangle.

2. Select the Field Settings option.
The Field Settings dialog is displayed.

3. Enter the default value for the column in the Default Expr text box.
This default value is used for the column, whenever you add a new row.
The Include existing rules check box is activated.

4. Select the Include existing rules check box to fill all the blank cells for the column with the default
value specified in the Default Expr text box.

5. Click OK.
The Field Settings dialog closes.

Result

Now the value of the Default Expr field is used as the default value for the column for new rules. If you
have selected the Include existing rules check box, all empty cells for the column in the decision table
are replaced by the default value.

Viewing or Hiding Columns in the Decision Table
To avoid scrolling tables with large number of columns, you can view only the columns that you want
in the decision table and hide all others.

Procedure

1. Open the column's options menu by either of the following ways:

● Right-click any one of the column headers.

● Hover the mouse pointer to any one of the column headers to view the down-pointing triangle
and click the triangle.

2. Select the Columns option and select or clear the column that you want to hide or view.
The check marks in front of the column names identify whether the column is visible or hidden. You
can select or clear the entire condition and action columns by selecting or clearing the Conditions
and Actions option in the menu.

Resizing a Column
To view the conditions and actions value better, you can resize the column of a decision table.

Procedure

● Perform any of the following actions to resize a column in the TIBCO BusinessEvents WebStudio:
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● Drag the right boundary of a column to manually resize them.
● Right-click on the column header you want to resize and click Auto Fit to resize the column to

fit to the content size.
● Hover the mouse pointer to the column header to view the down-pointing triangle. Click the

triangle and click Auto Fit to resize the column to fit to the content size.
● Double-click the right boundary of a column to make it auto fit to the content size.
● Right-click on the column header you want to resize and click Auto Fit All Columns to resize

all columns to fit their content size
● Hover the mouse pointer to the column header to view the down-pointing triangle. Click the

triangle and click Auto Fit All Columns to resize all columns to fit their content size.

You now have the ability to expand and collapse columns. No more scrolling is required if you want
to see selected columns from the decision table which has a large number of columns. Right-clicking
the decision table columns will show you the "Columns" option to either hide or show these
columns.

Removing a Column
Remove a column when you need to remove the condition or action for the entire decision table.

You cannot remove the last condition column because a minimum of one condition column must exist
if you have any action columns.

Procedure

● Right-click the column header and click Remove to remove the column from the decision table.

Sorting the Decision Table
The rows of a decision table can be viewed in an ascending or descending order of the selected column.

In page view, the sorting is performed only for the page and not the entire decision table. If you wish to
perform the sorting for the entire decision table, then first click Show All to disable the page view and
then perform the sorting.

Sort options are not available for columns with Boolean entry values and for custom condition and
action columns.

Procedure

● There are more than one way to sort the rows of a decision table in the BusinessEvents WebStudio.

● Click once on the column header to sort the table in ascending order of the column and click
again on the column header to re-sort the table in descending order of the column.

● Hover the mouse pointer over the column header to view the down-pointing triangle. Click the
triangle and select Sort Ascending or Sort Descending to sort the table in ascending or
descending order of the column.

● Right-click on the column header you want use for sorting and select Sort Ascending or Sort
Descending to sort the table in ascending or descending order of the column.

Setting Row Priorities
Each row in a decision table represents a separate business rule. You can control the order in which sets
of rows are executed using the row priority setting.

Rows with higher priorities are executed before those with lower priorities, as follows:

97

TIBCO BusinessEvents® WebStudio User's Guide



● First, all conditions are checked for all rows that have the highest priority. The checking order
within a set of rows with the same priority is not determinate.

● Then the rule actions for all of those rows whose conditions evaluate to true are executed. The
execution order is not determinate. The runtime engine optimizes rule execution.)

● The process is repeated for all rows with the next highest priority, and so on.

Ten is the lowest priority and one is the highest. Five is the default priority.

Procedure

1. Select the row whose priority you want to set.

2. Click the Properties icon  to display the Properties view.

3. In the Properties view, and select the Rule side-tab.

4. In the Priority field, select the appropriate value.

5. Click the Save icon  in the Edit toolbar to save the changes to the decision table.

Filtering the Rows
Apply filters to focus on certain rows instead of entire table.

Apply filters on multiple columns for more refined results. In TIBCO BusinessEvents WebStudio
decision table filter makes only textual comparison between the row values and filter values.

If you are viewing the decision table in page view, you can only filter values on the displayed page and
not the complete decision table. If you wish to use the filter for the entire decision table, then first click
Show All to disable the page view and then use the filter.

Procedure

1. To apply the filter, click Filter > Decision Table . Enter the values in filter cells (above column
header) to filter the table.

2. To remove the filter, click Filter > Remove in the decision table editor.
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Creating Duplicate Rows
You might want to create Duplicate rows, when you have only minor condition or action of the existing
rows to create a new rule, instead of creating the entire row from start.

When you duplicate rows in the page view, the duplicate rows are still added to the end of the decision
table, but are shown on the same page as original rows. The table is reorganized when it is closed and
reopened, thus the duplicate rows are then be displayed at the end of the decision table.

Procedure

1. In the Decision Table editor, select the Decision Table rows that you want to duplicate and click
Duplicate Row.

New rows are added, at the end of decision table, with the same conditions and actions of selected
rows, but with a different ID.

2. Edit the rows as needed.

Removing a Row
Remove the row if you want to delete the rule entirely instead of editing it. You can remove only one
row at time.

Procedure

1. In the decision table editor, select the rows you need to remove and click Remove.

2. In the Remove Decision Table Record window, click OK to confirm the removal of the row.

Supported Operators
TIBCO BusinessEvents WebStudio supports several operators for Decision Tables that you can use in
the expressions.

Named or Scoped Conditions must Evaluate to Boolean

For logical operators, named conditions will have to use them explicitly from the second operand
onwards.

For example, if the LHS of the condition is the column name, bankuser.Age, the following are valid
entries:
50 || ==60 , 20 || >=80

Custom Conditions must evaluate to Boolean

Same as above, except that you must specify the entire Boolean expression in the cell, including LHS.

Actions or Custom Actions

Named actions perform assignment of the cell expression to the column name property.
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Custom actions are treated as normal strings and can be anything that you would enter in the THEN
section of rules (LHS included).

Supported Operators

Operator Description

== Equals to

!= Does not equal to

> Greater than

>= Greater than or equals to

< Less than

<= Less than or equals to

|| Logical OR

&& Logical AND

+ Addition or String concatenation (depending on context)

! Logical NOT (only with boolean)

- Subtraction

* “Don’t Care” (that is, ignore), or multiplication (depending on context)

/ Division

= Assignment

. Scope resolution

() Operator precedence order or function call (depending on context)

[] Array declaration or array indexing (depending on context)

{} Block resolution or array Initialization (depending on context)

++ Increment (used only with custom actions)

-- Decrement (used only with custom actions)

Editing Domain Models
Using RMS, you can manage the lifecycle of domain models, and edit them in TIBCO BusinessEvents
WebStudio.
You can create a domain model only in BusinessEvents Studio; however, you can edit them in Studio as
well as WebStudio. See WebStudio Domain Model Editor Reference for more details on the domain
model editor fields. The updates are committed in the RMS and are available to all user after the
approval.
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See TIBCO BusinessEvents Developer's Guide for more information on domain models.

Prerequisites

Ensure that Project is selected under the Groups section in WebStudio.

Procedure

1. Double-click the domain model you want to edit.
The domain model editor is displayed.

2. Edit the domain model as required in the editor.

3. Click the Save icon to save the updates.

4. Click the Commit icon to commit the changes to RMS for approval.
Once approved all users can see the updates after synchronization.

WebStudio Domain Model Editor Reference
In WebStudio, using the domain model editor you can edit the domain model entries. You can also
configure the domain model to inherit entries from another domain model in the project.

Configuration

In the Configuration section, you can configure the basic domain model information.

WebStudio Domain Model Editor Configuration Properties

Field Description

Description Description of the domain model.

Domain Type The data type of the domain model. The values
are:

● String

● Int

● Long

● Double

● Boolean

● DateTime

You can edit the Domain Type field
only if there are no domain entries in
the domain model.

Inherits From Specifies the domain model from which the
domain entries are inherited. Click Browse to
select another domain model in the project from
where you can inherit the domain entries.

Domain Entries

The Domain Entries section lists all the domain entries, that you can edit.
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WebStudio Domain Model Editor Domain Entries Commands

Commands Description

Add Add a new domain entry to the domain model.
The new entry is appended at the end of the
domain entries list.

Remove Remove the selected domain entry from the
domain model.

Duplicate Create a duplicate of the selected domain entry
at the of the domain entries list.

WebStudio Domain Model Editor Domain Entries Columns

Column Name Description

Description Name of the domain entry.

Value Displays the value of the domain entry. Value
can be edited in the Details section.

Details

In the Details section you can enter the value of the domain entry based on the Domain Type.

WebStudio Domain Model Editor Details

Data Type Description

String String entries are simple text strings.

Integer, Double, Long In a single domain model, you can enter single
values, range values, or a mixture of both.
Acceptable values for integer, long, and double
domain entries are the same as for the equivalent
Java datatypes.

Boolean Boolean entry values are always true or false.
The description can give the meaning of the pair
of choices, such as male or female, supported or
unsupported, eligible or ineligible and so on.

DateTime In a single domain model, you can enter single
values, range values, or a mixture of both. You
specify a date and a time. Using the date picker
you can select the date.

Business Rules
Business Rules artifact allows non-technical business users to build complex business rules in TIBCO
BusinessEvents WebStudio.
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Adding Business Rules
Business Rules are created using the Rule templates developed in TIBCO BusinessEvents Studio. If a
rule template view is associated for the rule template, the business rule has an easy-to-use form based
interface to specify conditions and actions; otherwise, conditions and actions are added using the
builder.

See TIBCO BusinessEvents Developer’s Guide for overview on rule template, and rule template view.

A business rule in a project is identified by the .ruletemplateinstance file extension. The rule
template instance file is generated when the BuildAndDeploy option is selected for the business rule in
approvals. See Generating and Deploying the Business Rule’s Rule Template Instance for more details.

Adding a Business Rule Using the HTML Form

If a rule template view is defined for the rule template, then you can provide values for the bindings,
defined in TIBCO BusinessEvents Studio, in a HTML form.

The form interface is the visual presentation of the rule template defined by rule template views. See
TIBCO BusinessEvents Developer’s Guide for more details on rule template views.

Procedure

1. In TIBCO BusinessEvent WebStudio, under the Group Contents section, right-click the rule
template you want to use and select Create Business Rule.

2. Type the business rule name in the dialogue box and click OK.
If needed, you can enter a new folder name in the Parent Folder field and the new folder is created
in the project.
If the rule template view is defined for the rule template, then the HTML form is presented in the
business rule editor. Based on the data types in the rule template view, the HTML element are
generated for the HTML form.

Rule Template Data Type and HTML Field Type Mapping

Rule Template Data Type HTML Field Type

Integer Textbox

Double Textbox

String Text Area

Boolean Check box

String (with associated domain model) Dropdown list

Datetime Datetime widget

Long Textbox

3. Enter the threshold values in the input fields of the HTML form.

4. Click the Save icon  to save updates to the business rule.
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Adding a Business Rule Using the Builder Interface

If the rule template view is not defined for the rule template, then you can build conditions and actions
using various operators in the builder style of user interface .

The builder for business rule in the TIBCO BusinessEvents WebStudio consists of two sections: When
section (condition builder) and Then section (command builder).

Creating a New Business Rule

A new business rule needs to be created from the rule template, without the rule template view, to add
conditions and actions to it.

Procedure

1. In TIBCO BusinessEvent WebStudio, under the Group Contents section, right-click the rule
template you want to use and select Create Business Rule.

2. Type the business rule name in the dialogue box and click OK.
If needed, you can enter a new folder name in the Parent Folder field and the new folder is created
in the project.
If the view is not associated with the rule template, a builder interface opens up in the editor.

Adding a Conditional Clause Using the Condition Builder

The When section lets the user define additional conditions that must be met, in addition to the pre-
condition defined in the Rule Template.

The builder determines the scope of the rule template, and allows the user to define individual
conditional clauses based on that scope. Each conditional clause has one or more sub-clause, and a
match operator determines whether the conditional clause is true when all sub-clause are true, or any
one sub-clause is true, or none of the sub-clauses evaluate to true.

If you require to move any condition up or down the order then you can drag-and-drop the condition
to move it. Move the mouse pointer over any condition till the pointer is converted to a drag icon. Now,
you can drag that particular condition and drop it within same or different filter.

Procedure

1. In the business rule editor, under the When section, click the artifact-name link and select the
artifact you require.

2. Click the operator-name link to select another operator, or a child artifact of the previously selected
artifact, as you require. See Condition Builder Operators for list of supported operators.
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3. Enter the conditional value for the artifact in the empty box.

4. Click the Add icon  to another condition to the conditional clause, or click the Remove icon  to
remove the existing condition from the conditional clause, if you want.

5. Click the Add Sub-clause icon  to add a conditional sub-clause to the conditional clause, if you
want.

6. Click the match-operator link to select the matching condition for which the conditional clause
evaluates to true. The values are:
Option Description

Match Any Conditional clause is true if any of the condition evaluates to true.

Match All Conditional clause is true only if all of the conditions evaluates to true.

Match None Conditional clause is true only if none of the conditions evaluates to true.

7. Click the Save icon  to save updates to the business rule.

Adding an Action Using the Command Builder

The Then section defines additional actions to be taken based on the conditions defined.

The builder lets the user define actions based on the statements defined in the Action Context section of
the rule template.

Ensure that all the actions in the business rule are defined and the order should match that of the rule
template. Otherwise, the business rule will be invalid.

Procedure

1. In the business rule editor, under the Then section, click the Action dropdown list to select the
actions available for the rule template.

2. Click the artifact-name link and select the artifact you want modify.
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3. Click the operator-name link and select the command for the artifact. See Action Builder Operators
for list of available on operators.

4. Type the value, you want to set for the artifact, in the empty box.

5. Click the Add icon  to add another parameter for the action, or click the Remove icon  to remove
the parameter for action, if you want.

6. Click the Save icon  to save updates to the business rule.

Business Rule Properties

You can set optional description and priority of the Business Rule using the General properties.

General Business Rule Properties

Property Description

Name Read only. Displays name of the business rule.

Priority Specifies the business rule priority from 1 to 10. The order in which rules are
executed can be defined using the Priority property.

The default value is 5.

Description Optional. Description of the business rule.

Exporting a Business Rule
You can export business rules from TIBCO BusinessEvents WebStudio to rule template instance file.

A business rule in a project is identified by the .ruletemplateinstance file extension. The rule
template instance file is generated when the BuildAndDeploy option is selected for the business rule in
approvals. See Generating and Deploying the Business Rule’s Rule Template Instance for more details.

The sample file content of the exported rule template instance file is:
<?xml version="1.0" encoding="UTF-8"?>
<RuleTemplateInstance id="738cd4ea-8569-4744-aa86-fb88a89bf0a3" implementsPath="/
Rule_Templates/Applicant_PreScreen">
    <actions/>
    <binding id="minimumIncome" value="5000"/>
    <binding id="minimumAge" value="25"/>
    <binding id="creditType"/>
</RuleTemplateInstance>

Procedure

1. Open the Export dialog box in either of the following ways:
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● Select the business rule and in the Tools tool bar, click the Export icon  .

● Right-click the business rule in the Group Contents section and select Export.

2. Navigate to the directory in which you want to save the rule template instance file and provide a file
name.

3. Click Save.

Deleting a Business Rule
If you want to delete a business rule that has been checked into the RMS project, then you must submit
the deletion for approval.

After approval, the deleted business rule is removed from the RMS project, but it is not removed from
the user’s workspace.

If you are not sure whether the business rule you deleted was committed to the RMS project in a prior
action, select Project > Commit . If the deleted business rule does not appear in the Changes Made
panel, then it is a local business rule.

Procedure

1. Do one of the following:

● In Group Contents, right-click the business rule name and select Delete.

● In Group Contents, select the business rule name. Then click the Delete icon  in the Edit
toolbar.

2. If the business rule has been committed to the RMS project, select one of the following options as
appropriate:

● Commit the project or the parent folder so that the RMS master copy of the business rule can be
deleted after the approval (see Committing Artifacts for Approval). OR

● Synchronize the project to replace the deleted copy with the RMS project version of the
business rule (see Updating (Synchronizing) a Project).

Users who have already checked out the project must manually delete their local copy of
the artifact.

Renaming a Business Rule
You can rename a business rule in WebStudio to a more suited name that identifies its functionality
more appropriately.

Procedure

1. In Group Contents, right-click the business rule name and select Rename.

A business rule name can contain letters, numbers, and underscore only. It should start
with a letter and be less than 64 characters.

WebStudio displays the Rename completely successful message.

2. If the business rule has been committed to the RMS project, commit the project or the parent folder
so that the RMS master copy of the business rule is also renamed.
The changes appear in two entries: one with the Change Type as Added and other with the Change
Type as Removed in the Commit window and the Worklist window. Commit both the entries
together as a single commit; otherwise WebStudio displays an error.
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Business Rule Operators
Business Rule builder operators consists of the conditional clause operators and the action builder
operators. The operator list changes as per the parent entity type in the builder.

Condition Builder Operators

Operator Value on WebStudio
Client Parent Type Operator Value on RMS Server

Matches Other Field
● Concept /

Event

● Data / Time /
Datetime

● Integer / Float

● Text / String

● Boolean

== <field>

Differs From Field
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

● Boolean

!= <field>

Is Null
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

== null

Is not Null
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

!= null

Greater Than Integer / Float >

Greater Than Field Integer / Float > <field>
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Operator Value on WebStudio
Client Parent Type Operator Value on RMS Server

Greater Than Equal To Integer / Float >=

Greater Than Equal To Field Integer / Float >= <field>

Less Than Integer / Float <

Less Than Field Integer / Float < <field>

Less Than Equal To Integer / Float <=

Less Than Equal To Field Integer / Float <= <field>

Equals
● Integer / Float

● Text / String

● Boolean

==

Not Equals
● Integer / Float

● Text / String

● Boolean

!=

Action Builder Operators

Operator Value on WebStudio
Client Parent Type Operator Value on RMS Server

Set To
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

=

Set To Field
● Concept /

Event

● Date / Time /
Datetime

● Integer / Float

● Text / String

● Boolean

= <field>
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Operator Value on WebStudio
Client Parent Type Operator Value on RMS Server

Set To Null
● Concept /

Event

● Integer / Float

● Text / String

= null

Increment By Integer / Float +=

Increment By Field Integer / Float += <field>

Decrement By Integer / Float -=

Decrement By Field Integer / Float -= <field>

Set To True Boolean = true

Set To False Boolean = false

Process
You can use the WebStudio software to create and design a new process without opening the
BusinessEvents Studio.

Using WebStudio, you can design the complete process and set the General and Documentation
properties, which instructs the developers on what to implement for the process.

Processes are available in TIBCO BusinessEvents WebStudio in the view mode and the edit mode only
if you have the TIBCO BusinessEvents Process Orchestration add-on installed on your system.

The process editor contains three sections:

● Diagram Editor - You can design the process in the diagram editor by adding the component from
the palette. It has a toolbar, using which you zoom in or zoom out, change how the components are
arranged, undo the command, print the command, and so on. Hover you mouse over each tool to
see the toolptip, which displays the tool's name.

● Properties - The Properties section contains two common tabs: General and Documentation. Using
the General tab, you can specify the Name, Label, and Resource for the component. You can write
instructions for the developers on what to implement for the process components, using the
Documentation tab. After the process is committed in RMS and approved, the developers can see
these documented instructions in the TIBCO BusinessEvents Studio after logging into RMS.

● Palette - All the components that you can use to design the process diagram are categorized in
different palettes. See Process Palette Reference for a complete list of available components in
WebStudio.
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Process Editor in TIBCO BusinessEvents WebStudio

Adding a New Process
You can create a new process and design the complete process flow in WebStudio.

Procedure

1. In the My Workspace tab, under the Group Content section, click the Change View icon and
select Show items as a tree (if not already selected).
The project artifacts are now displayed in the tree structure.

2. Right-click the folder where you want to add the new process and select New Process.
The New Process window is displayed.

3. Specify the process name in the Process field. If needed, you can change the parent folder name to
an existing folder or a new folder in the Parent Folder field.
The new process is added to the project and is displayed in the process editor for update.

Result

The new process contains three basic components by default: Message_Start_0, Message_End_0, and
Script_0. You can add other components from the palettes. Click the component in the palette and click
the editor to add the component.

Deleting a Process
If you want to delete a process that has been checked into the RMS project, you must submit the
deletion for approval.

After approval, the deleted process is removed from the RMS project, but it is not removed from the
user’s workspace.

If you are not sure whether the process you deleted was committed to the RMS project in a prior action,
select Project > Commit . If the deleted process does not appear in the Changes Made panel, it is a local
process.
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Procedure

1. Do one of the following:

● In Group Contents, right-click the process name and select Delete.

● In Group Contents, select the process name. Then click the Delete icon  in the Edit toolbar.

2. If the process has been committed to the RMS project, select one of the following options as
appropriate:

● Commit the project or the parent folder so that the RMS master copy of the process can be
deleted after the approval (see Committing Artifacts for Approval). OR

● Synchronize the project to replace the deleted copy with the RMS project version of the process
(see Updating (Synchronizing) a Project).

Users who have already checked out the project must manually delete their local copy of
the artifact.

Process Palette Reference
The Palette in WebStudio contains the components you can use to design a process diagram.

General

Name Description

Note A free-form text note.

Association An association is a dotted line that links flow
objects with non-flow objects such as text
annotations.

Sequence Flow A link or transition between two activities is
called a sequence flow.

Tasks

Name Description

Script Executed using a TIBCO BusinessEvents rule
function

Business Rule Executed using a TIBCO BusinessEvents
Decision Manager decision table

Send Message Sends a TIBCO BusinessEvents event to its
default destination

Receive Message Receives a TIBCO BusinessEvents event

Web Service Executed using a web service

Inference Executed using a TIBCO BusinessEvents rule
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Name Description

Call Activity Executed using a private process

Gateways

Name Description

Exclusive Used to execute one sequence flow of execution
after evaluating multiple sequence flows in a
process

Parallel Used to execute concurrent multiple flows of
execution

Start Events

Name Description

Start No trigger.

Message Start Triggered by a simple event from a queue-based
destination.

Timer Start Triggered by a time event.

Signal Start Triggered by a simple event from a topic-based
destination. Multiple processes can be triggered
by the same event.

End Events

Name Description

End No action occurs

Message End Sends a simple event to a queue-based
destination

Error End Throws an appropriate error

Signal End Sends a simple event to a topic-based destination

Renaming a Process
You can rename a process in WebStudio to a more suited name that identifies its functionality more
appropriately.

Procedure

1. In Group Contents, right-click the process name and select Rename.
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A process name can contain letters, numbers, and underscore only. It should start with a
letter and be less than 64 characters.

WebStudio displays the Rename completely successful message.
2. If the process has been committed to the RMS project, commit the project or the parent folder so that

the RMS master copy of the process is also renamed.
The changes appear in two entries: one with the Change Type as Added and other with the Change
Type as Removed in the Commit window and the Worklist window. Commit both the entries
together as a single commit; otherwise WebStudio displays an error.

Approval Workflow Overview
After updating the artifacts (decision tables or business rules), submit them for approval. All business
user actions, such as committing or deleting artifacts are committed to the RMS project only after a
approver approves those updates.

The approval permissions are set at the project level using the ACL file for the project. Allow the
approval action type for the user role in the ACL file to the grant approval permission. See TIBCO
BusinessEvents Administration for details on setting permission for a user role at the project level.

This manual documents the behavior of the product as shipped. The workflow, the roles used, and the
permissions granted to the roles are all configurable. However, the general flow is likely to be similar to
that described in this guide.

Use of RMS—and therefore the approval process—is required when TIBCO BusinessEvents WebStudio
is used.

See Committing Artifacts for Approval for business user procedures.

See Working with the Worklist Items for approver procedures.

Who Can Approve or Reject Commit Requests

In TIBCO BusinessEvents WebStudio users with Administrator role permissions can approve or reject
commit requests, or delegate approval. They can also delegate the task of approving or rejecting
commit requests to any specified user role and not to a specific user. In this case, the approval or
rejection requests will be sent to all the users in that role. See Delegating a Workitem from Worklist.

Approval Status Values

COMMITTED
 When a user commits one or more resources for approval, the status of the request is set to
Committed. The approver then sets the status as appropriate.

APPROVE
 The request was approved. If the submission request was to add or change an artifact, that artifact is
copied to the RMS project. If the submission request was to delete an approved artifact, that artifact is
deleted from the RMS project.

REJECT
 The change was rejected. If the submission request was to add or change an artifact, that artifact is not
copied to the RMS project. If the submission request was to delete an approved artifact, that artifact is
not deleted. It is up to the business user to make changes in their local project accordingly.

BUILDANDDEPLOY
 The artifact is built and hot deployed. The artifact after approval is built and hot deployed at the
location specified by a property in the RMS.cdd file. See the following sections on how to build the
artifact and hot deploy it:

● Generating and Deploying the Decision Table’s Class File
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● Generating and Deploying the Business Rule’s Rule Template Instance

● The BUILDANDDEPLOY status is not applicable for the Process artifacts.

● If the <ProjectName>.<EnvironmentName>.ws.jmx.hotDeploy.enable property is set to false
then the BUILDANDDEPLOY option only compiles the classes but do not hot deploy them.

Worklist
Approval requests are handled in the Worklist window in TIBCO BusinessEvents WebStudio. You can
take the appropriate approval action on single or multiple artifacts at a time in the Worklist window.

Worklist have multiple columns to provide more information about each request:

Revision ID
Unique ID assigned to each revision by WebStudio.

User name
Username of the user who had performed the commit.

Project
Project name of the artifact.

Commit comments
Comments provided by user at the time of the commit.

Commit time
RMS system time of the commit.

Viewing Differences between Committed and Previous Version of Artifact
View the updates that have been made in the committed version, from the previous approved version
of the artifact in RMS, before approving or rejecting the request.

Procedure

1. Open the worklist window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Show
Worklist .

● Right-click any artifact and select RMS > Show Worklist .

● Click the Show Worklist icon  in the RMS toolbar.

The worklist window displays all the requests submitted for approval.

2. To view the artifacts submitted for approval, click the triangle in front of the Revision ID.

3. Right-click the modified artifact and select Diff with Previous Version.
The updated artifact is displayed with the updates highlighted in different colors for addition,
deletion, and modification. Refer to the legends displayed on the editor for the significance of each
highlighted color. Hover the mouse pointer over the highlighted (modified) part to see the previous
value.

4. After viewing changes, open the worklist again to approve or reject the commit request (see 
Approving or Rejecting a Commit Request from Worklist).

115

TIBCO BusinessEvents® WebStudio User's Guide



Approving or Rejecting a Commit Request from Worklist
Approve or reject requests after they are committed to RMS. You should have allow permission for the
approval action type in the project’s access control file.

Procedure

1. Open the worklist window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Show
Worklist .

● Right-click any artifact and select RMS > Show Worklist .

● Click the Show Worklist icon  in the RMS toolbar.

The worklist window displays all the requests submitted for approval.

2. To view the artifacts submitted for approval, click the triangle in front of the Revision ID. To
examine the artifact before taking an action, double-click the artifact. The decision table or business
rule displays in the editor.

3. To take action on an artifact, click the Committed status under the Status column, and select a value
from the Status drop-down list:

● Approve

● Reject

A message field displays the error messages in the event of a problem.

4. Click anywhere outside the drop-down menu and click Ok.

Delegating a Workitem from Worklist
A user in the Administrator role can delegate a workitem to one or more roles. Users belonging to any
of those roles see the workitem in their worklist.

Users in the role specified by the RMS global variable property tibco.clientVar.RMS/Approval/
adminRole have Administrator role privileges. See Configuring RMS Server Properties .

Procedure

1. Open the worklist window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Show
Worklist .

● Right-click any artifact and select RMS > Show Worklist .

● Click the Show Worklist icon  in the RMS toolbar.

The worklist window displays all the requests submitted for approval.

2. Select the checkbox for one or more Revision IDs you need to delegate.

3. Select one or more user roles from the DelegateTo dropdown list and click Apply.
You see all roles that you do not belong to, and that have permission to approve or reject the artifact.
The workitem disappears from your worklist. It can be seen in the worklist of the users in the roles
you selected.

116

TIBCO BusinessEvents® WebStudio User's Guide



Deleting Workitems from Worklist
You can delete the workitems from your worklist, which are either in the Approve or Reject status.

The WebStudio displays the following error message if you try to delete any workitem revision which
has even a single artifact in the Commit status:
Revisions having artifacts which are not yet approved cannot be deleted.

Individual artifacts entry could not be deleted from the worklist. Only complete revisions could be
deleted, after all its artifacts are in the Approve or Reject status.

Prerequisites

Approve or reject the commit request before deleting the workitems from the worklist.

Procedure

1. Open the worklist window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Show
Worklist .

● Right-click any artifact and select RMS > Show Worklist .

● Click the Show Worklist icon  in the RMS toolbar.

The worklist window displays all the requests submitted for approval.

2. Select the check box for one or more Revision IDs you need to delete.

3. Select Delete from the drop-down list and click Apply. All the selected revisions are now deleted
from your worklist and WebStudio displays the Revision(s) [Revision ID] successfully
deleted message.

Generating Deployable Files (EAR and Class Files)
Deployable files are generated using the TIBCO BusinessEvents Studio project files, located in the RMS
project’s folder.

The deployable files are of two types: EAR files and class files.

EAR files
EAR files are generated in Decision Manager and TIBCO BusinessEvents WebStudio UI.

Class files
You can generate class files using Decision Manager and TIBCO BusinessEvents WebStudio UI, or at
the command line. You can generate an entire project’s class files, one decision table’s class file, or one
business rule’s rule template instance file. If you generate an entire project’s class files, a property in
the CDD file enables you to exclude unwanted packages.

You can generate class file of one decision table and rule template instance file for business rule, only
using TIBCO BusinessEvents WebStudio.

Generating the Project EAR or All Project Class Files
You can generate deployable EAR files only if you have the permission to check out all the required
project resources (ACLs may limit what you can check out).
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Procedure

1. Open the Generate Deployable window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Generate
Deployable .

● Right-click on any artifact and select RMS > Generate Deployable .

● Click the Generate Deployable icon  in the RMS toolbar.

The Generate Deployable window is displayed.

2. Do one of the following:

● To generate class files, select the Generate Classes Only checkbox.
● To generate EAR files, do not select the Generate Classes Only checkbox.

3. From the drop-down list, select the project for which you want to generate the deployable files.

4. (For EAR files only.) If you want to generate the debug information, select the Generate Debug Info
checkbox.

5. (For EAR files only.) If you want to include all service-level global variables, select the Include all
service level global variables checkbox.

6. Click OK.

Result

Files are saved to the preconfigured location (see Generated Files Location). Any existing files are
overwritten.

Generating and Deploying the Decision Table’s Class File
In TIBCO BusinessEvents WebStudio, using the BuildAndDeploy status menu option in the Worklist
window you can generate the class file and hot deploy the decision table.

You can generate one decision table’s class file using TIBCO BusinessEvents WebStudio only.

Prerequisites

● For generation of class file and hot deployment of a decision table, you must have a generated EAR
for the project. See Generating the Project EAR or All Project Class Files for more details.

● Ensure that JMX connection details for the environments where you must deploy are configured for
the projects in the hot deploy properties group in the RMS.cdd file. See Hot Deploy Property Group
Reference for more details on the hot deploy properties. Using these properties you can deploy
multiple projects in a single environment or a single project in multiple environments.

● For hot deployment of the decision table, ensure that the project's CDD file (for which the decision
table is hot deployed) have the <ProjectName>.<EnvironmentName>.ws.jmx.hotDeploy.enable
property set to true. See Hot Deploy Property Group Reference for more details on the hot deploy
properties.

● You can generate the class file and hot deploy a decision table only after it is approved. See Working
with the Worklist Items on how to approve a committed request.

● For hot deployment of the decision table, ensure that the project's CDD file (for which the decision
table is hot deployed) have the be.engine.cluster.externalClasses.path property under the
appropriate processing unit, for example default. The property points to the location where
artifacts are generated and also identified by the RMS property ws.artifact.deploy.location
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(see Common Property Group for more details on the property). For example, the decision table
class file for the CreditCardApplication project is stored at BE_HOME\rms\shared
\CreditCardApplication.

Procedure

1. Open the worklist window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Show
Worklist .

● Right-click any artifact and select RMS > Show Worklist .

● Click the Show Worklist icon  in the RMS toolbar.

The worklist window displays all the requests submitted for approval as well as approved
requests.

2. To view the approved decision tables, click the triangle in front of the Revision ID. To examine the
decision table before taking an action, double-click the table.
The decision table displays in the editor.

3. To generate classes and hot deploy the decision table, click the Approved status under the Status
column, and select BuildAndDeploy from the status drop-down menu.

If the <ProjectName>.<EnvironmentName>.ws.jmx.hotDeploy.enable property is set
to false then the BuildAndDeploy option only compiles the classes but do not hot deploy
them.

WebStudio performs auto-validation of the artifact to ensure that the update does not affect the
runtime execution.
A message field displays error messages in the event of a problem.

4. To start generating classes click anywhere outside the drop-down menu and click Ok.

Generating and Deploying Business Rules
In TIBCO BusinessEvents WebStudio, using the BuildAndDeploy status menu option in the Worklist
window you can generate the rule template instance file and hot deploy the business rule.

Prerequisites

● For generation of rule template instance file and hot deployment of a business rule, you must have a
generated EAR for the project. See Generating the Project EAR or All Project Class Files for more
details.

● Ensure that JMX connection details for the environments where you must deploy are configured for
the projects in the hot deploy properties group in the RMS.cdd file. See Hot Deploy Property Group
Reference for more details on the hot deploy properties. Using these properties you can deploy
multiple projects in a single environment or a single project in multiple environments.

● For hot deployment of the business rule, ensure that the project's CDD file (for which the business
rule is hot deployed) have the <ProjectName>.<EnvironmentName>.ws.jmx.hotDeploy.enable
property set to true. See Hot Deploy Property Group Reference for more details on the hot deploy
properties.

● You can generate the class file and hot deploy a decision table only after it is approved. See Working
with the Worklist Items on how to approve a committed request.

● For hot deployment of the business rule, ensure that the project's CDD file (for which the business
rule is hot deployed) have the be.cluster.ruletemplateinstances.deploy.dir property under
the appropriate processing unit, for example default. The property points to the location where
artifacts are generated and also identified by the RMS property ws.artifact.deploy.location
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(see Common Property Group for more details on the property). For example, the rule template
instance file for the CreditCardApplication project is stored at BE_HOME\rms\shared
\CreditCardApplication.

Procedure

1. Open the worklist window using any of the following methods:

● Click WebStudio, with the down-pointing triangle in front of it, and select RMS > Show
Worklist .

● Right-click any artifact and select RMS > Show Worklist .

● Click the Show Worklist icon  in the RMS toolbar.

The worklist window displays all the requests submitted for approval as well as approved
requests.

2. To view the approved business rules, click the triangle in front of the Revision ID. To examine the
business rule before taking an action, double-click the rule.
The business rule is displayed in the editor.

3. To generate rule template instance file and hot deploy the business rule, click the Approved status
under the Status column, and select BuildAndDeploy from the status drop-down menu.

If the <ProjectName>.<EnvironmentName>.ws.jmx.hotDeploy.enable property is set
to false then the BuildAndDeploy option only compiles the classes but do not hot deploy
them.

WebStudio performs auto-validation of the artifact to ensure that the update does not affect the
runtime execution.
A message field displays error messages in the event of a problem.

4. To start generating rule template instance file, click anywhere outside the drop-down menu and
click Ok.

Generated Files Location
Location of generated files can be configured using deploy location properties in the RMS.cdd file.

See RMS Server Configuration Property Reference for more details on deploy location properties.
Below are the locations of the generated files as per the preconfigured locations in the shipped product.

● EAR files are saved in the RMS project directory in the RMS’s shared directory. For example, EAR
file for CreditCardApplication project is stored at BE_HOME\rms\shared
\CreditCardApplication.

● Project’s class files are saved in the codegen subdirectory under the RMS project directory in the
RMS’s shared directory. For example, class files for CreditCardApplication project are stored at
BE_HOME\rms\shared\CreditCardApplicatio\codegen

● Individual decision table’s class file and business rule’s rule template instance are saved in the RMS
project directory in the RMS’s shared directory.
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Changing the TIBCO BusinessEvents WebStudio Language for the Classic
UI

You can change the default language of TIBCO BusinessEvents WebStudio classic UI from American
English (en_US) to other languages.

Prerequisites

Ensure that the language pack of the language, in which you want TIBCO BusinessEvents WebStudio to
be displayed, is installed. See TIBCO BusinessEvents Installation for more details.

Procedure

1. Clear the web browser cache.

2. Open TIBCO BusinessEvents WebStudio URL in the web browser. Put the locale=<language> or
locale=<language_country> as the query string of the URL and reload URL.

If you load the language that is not supported, the English language is picked up.

Variable names for the supported languages are as follows:

Language Variable name

German de

French fr

Italian it

Korean ko

Simplified Chinese CN

For example, to load WebStudio with the German language, specify the following URL:

http://localhost:8090/WebStudio/?locale=de

The URL is case sensitive.

WebStudio German Language Login Page
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Settings Page for the Classic User Interface

User Settings
This section provides options for personal preferences that you can set for WebStudio. These
preferences are same as settings that are present under the Preferences tab in the Settings page in the
classic user interface. For more details on these options, see Preferences Settings on page 72.

Applications Settings
Using the Application Settings, you can restrict the operators, and configure project-level email
notifications for each project. This section further categorizes the settings in the following preferences:

● Operator Preferences - Using the Operator section, you can restrict the operators available for
creating the Business Rule using the Builder interface in WebStudio. For more details on these
options, see Operator Settings on page 73 in the WebStudio classic user interface.

● Notification Preferences - Using the notification section, you can configure email notifications
based on the project action. For more details on these options, see Notification Settings on page 74
in the WebStudio classic user interface.

ACL Preferences
In ACL section, you can configure the access control file for each project. Also, you can configure the
users with roles in the password file.

The projects, for which the access control file is already set up, are displayed. For setting up a new
access control file for the project, refer to the TIBCO BusinessEvents Administration guide.

Using WebStudio, you can only configure an existing access control file but cannot create a new one for
the project.

ACL Settings Reference
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Callou
t
Numb
er

Section
Name Description

1 Roles Displays the list of roles which can be assigned to users. The list is picked up
from the access control file (.ac).

You can add or remove roles using this section:

● Click the Add icon to add a new role.

● Click the Remove icon  to remove the selected role.

Click Apply to apply the updates to user roles and users to the password file
(users.pwd).

2 User Displays the list of users with the selected user role (1). The list is picked up
from the password file (users.pwd)

This section is not displayed for the LDAP based authentication, as the users
are defined in LDAP.

You can add or remove a role for the users:

● Click the Add icon  to assign the selected role to a user.

● Click the Remove icon  to remove the selected user from the role.

Click Apply to apply the updates to user roles and users to the password file
(users.pwd).

3 Project
List

Displays the list of projects for which the access control files (.ac) are present
in RMS.

4 Resourc
es

Displays the list of resource for the projects. These resources are defined in the
access control file (.ac) for the selected project.

5 Actions Displays the actions available for the selected resource (4). Select the actions
that are allowed for the selected resource (4). Click Apply to assign the resource
access permission updates for the user role to the access control file (.ac) of the
project.

Only those actions, which are applicable for the selected resources (4), are
active.

See TIBCO BusinessEvents Administration Guide for more details on the access
control file.

Management Page Reference
On the Management page, you can configure the permissions for project items and get audit trail
reports.

The Management page has the following sections that you can configure:

Permission Management
Configures the permissions for the project items.
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Permission Management Options

Option Description

Users Displays the list of users configured in the rule management server with their user
role. The list is picked up from the password file (users.pwd)

This section is not displayed for the LDAP based authentication, as the users are
defined in LDAP.

You can add or remove a role for the users:

● Click the Add icon ( ) to add a new user. Provide the Name, Password, and
Role for the user.

● Click the Remove icon ( ) to remove the selected user.

Click Apply to apply the updates to the password file (users.pwd).

Roles Displays the configuration from the access control file for each project. This section
provides the same configuration that are defined under the ACL Preferences in the
WebStudio classic user interface. For more details on these configurations, see ACL
Preferences on page 122.

Locks Displays the list of locked artifacts for the projects. Select a project to view the list of
its locked artifacts and their details. You can also unlock the artifacts that you have
locked. Administrator can also unlock artifacts that are locked by other users. You can
also unlock all locked artifacts in one step using Unlock All. Click Apply to apply the
changes.

Report Management
Provides the option to get reports on the user activities.
The Audit Trail section displays the list of all actions performed in that session of rule management
server. You can also refine the results using the following available filters and click Apply.

The Audit Trail Filters

Fields Description

User Select the user for which you want to see all the actions performed.

Project Select the project to display actions for that project.

Artifact Enter the full name of the artifact according to its path to view audit trail for only
that artifact. For example, enter /Virtual_RF/Applicant to display results for
actions performed on the Applicant decision table.

Action Select the type of action for which you want to see the audit trail.

After
Date

Select the date and time to display only those actions that were performed after the
selected data and time.
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Fields Description

Before
Date

Select the date and time to display only those actions that were performed before
the selected data and time.

Log File Set the value to ON to save the results in a log file instead of displaying the results
on the screen.

In the results list, right-click on any item to see more options:

● Copy - Copy the row content.

● Copy with Headers - Copy the row content with headers.

● Tool Panel - Select the columns to display.

● Export - Export the list as a CSV or Microsoft Excel file.

Adding a New Custom Language Pack
You can manually translate TIBCO BusinessEvents WebStudio classic UI to a new language, if the
language you need is not available in the language pack.
There are about seven properties inside the locale JAR corresponding to various areas of the
application. The format is defined as filename_<language>.properties or
filename_<language_country>.properties.

Procedure

1. Browse to the BE_HOME/rms/lib/locales directory, which contains the locale JAR files.
Each JAR file correspond to a different language. The format of the locale JAR file is
<locale_name>.jar.

2. Create temporary directory and un-package the English JAR (en_US.jar) files into the temporary
directory.

3. Rename each of the property file with the corresponding language specific values.
There are about seven properties inside the locale JAR corresponding to various areas of the
application. The format is defined as filename_<language>.properties or
filename_<language_country>.properties.
For example, rename the property file from DTMessages.properties to
DTMessages_de.properties for the German language.

4. Open each of renamed property file and replace the values in each of the property file with the
corresponding language specific values.

5. Re-package the files back into the JAR file. Ensure the correct naming convention for the property
file as well as the JAR file.

What to do next

Refresh the web browser to see the changes in TIBCO BusinessEvents WebStudio. If you don't see the
changes, perform a browser cache cleanup (as sometimes the values are loaded from the cache) and
reload the URL.
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User Interface Customization

You can customize various aspects of BusinessEvents WebStudio classic user interface (UI) using the
WAR file.

UI customization is available only for WebStudio classic UI.

In WebStudio you can change the CSS styles (colors, borders, and so on), images, background images,
message strings, various titles and tooltips. Thus, you can create a new theme for WebStudio that is
more in line with your corporate theme. All the updates are completely reversible to the default theme.

You can change the following UI elements in WebStudio:

● Company logo

● CSS

● Images

● Message or properties

● Language

Customizing the Company Logo
WebStudio can be configured to display your company logo on the login page and the banner page.

Procedure

1. Extract the WebStudio.war file located at the BE_HOME/rms/bin/ folder.

2. In the extracted folder, open the WebStudio.html file in edit mode.

3. In the WebStudio.html file, set the value of the company_logo_url variable to the URL of your logo
image.
The URL can be a hyperlink to the logo image which might be hosted on some web-server, for
example, http://www.mycompany.com/images/logo.jpg. The URL can also point to an image on the
file system within the WebStudio folder hierarchy, for example, webstudio/images/logo.png.
Ensure that the image is present in the WAR file at the path specified.

To remove the company logo, set the value of the company_logo_url property to the
blank string (company_logo_url = "").

4. Save the HTML file and compress the folder back to the WebStudio.war file.

Customizing CSS
You can create a new theme, in line with your corporate theme, for WebStudio by configuring the CSS
of the WebStudio.

Procedure

1. Extract the WebStudio.war file located at the BE_HOME/rms/bin/ folder.

2. In the extracted folder, open the styles/custom_styles.css file in edit mode and populate it with
CSS styles that you want to update (override).
Refer to the instructions within the file. Save the file after the update.

3. In the extracted folder, open styles/WebStudio.css file in edit mode. Uncomment (remove #) the
first line to import custom_styles.css and save it.
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4. Compress the folder back to the WebStudio.war file.

Customizing Images
In WebStudio you can use your own customized images in place of the default images.
A typical example is a delete or add icon is represented through a very specific icon throughout all your
corporate applications and you want the same to appear in WebStudio.

Procedure

1. Extract the WebStudio.war file located at the BE_HOME/rms/bin/ folder.

2. In the extracted folder, back up the images folder by duplicating the folder at the same level with a
name, such as, my_images or any name of your choice.

3. Update the images under the duplicate folder (my_images) as per your requirement without
changing the file names.

4. Open the WebStudio.html file in edit mode.

5. In the WebStudio.html file, set the value of the images_dir variable to point to the my_images
folder.
For example,
var images_dir = “webstudio/my_images/”

6. Save the HTML file and compress the folder back to the WebStudio.war file.

To revert to the WebStudio’s default images, set the value of the images_dir variable to
“webstudio/images/” in WebStudio.html file.

Customizing Messages and Properties
If needed, you can customize messages and labels in WebStudio user interface (UI) to explain the right
meaning and context, or add a new language support.
See Adding a New Custom Language Pack for more details on customizing messages and properties
for a new language pack.

Procedure

1. Browse to the BE_HOME/rms/lib/locales directory, which contains the locale JAR files.
Each JAR (<locale_name>.jar) file correspond to a different language. Each JAR file
(filename_<locale_name>.properties) consist of the different properties files corresponding to
various areas of the application.

2. Extract the corresponding locale JAR file to edit one of the existing values of the properties.

3. Identify the files or properties that you need to change. Update the required files and properties and
compress it back into the JAR file.

What to do next

Refresh the web browser to see the changes in WebStudio. If you don’t see the changes, perform a
browser cache cleanup (as sometimes the values are loaded from the cache) and reload the URL.
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Changing the TIBCO BusinessEvents WebStudio Language for the Classic
UI

You can change the default language of TIBCO BusinessEvents WebStudio classic UI from American
English (en_US) to other languages.

Prerequisites

Ensure that the language pack of the language, in which you want TIBCO BusinessEvents WebStudio to
be displayed, is installed. See TIBCO BusinessEvents Installation for more details.

Procedure

1. Clear the web browser cache.

2. Open TIBCO BusinessEvents WebStudio URL in the web browser. Put the locale=<language> or
locale=<language_country> as the query string of the URL and reload URL.

If you load the language that is not supported, the English language is picked up.

Variable names for the supported languages are as follows:

Language Variable name

German de

French fr

Italian it

Korean ko

Simplified Chinese CN

For example, to load WebStudio with the German language, specify the following URL:

http://localhost:8090/WebStudio/?locale=de

The URL is case sensitive.

WebStudio German Language Login Page
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Adding a New Custom Language Pack
You can manually translate TIBCO BusinessEvents WebStudio classic UI to a new language, if the
language you need is not available in the language pack.
There are about seven properties inside the locale JAR corresponding to various areas of the
application. The format is defined as filename_<language>.properties or
filename_<language_country>.properties.

Procedure

1. Browse to the BE_HOME/rms/lib/locales directory, which contains the locale JAR files.
Each JAR file correspond to a different language. The format of the locale JAR file is
<locale_name>.jar.

2. Create temporary directory and un-package the English JAR (en_US.jar) files into the temporary
directory.

3. Rename each of the property file with the corresponding language specific values.
There are about seven properties inside the locale JAR corresponding to various areas of the
application. The format is defined as filename_<language>.properties or
filename_<language_country>.properties.
For example, rename the property file from DTMessages.properties to
DTMessages_de.properties for the German language.

4. Open each of renamed property file and replace the values in each of the property file with the
corresponding language specific values.

5. Re-package the files back into the JAR file. Ensure the correct naming convention for the property
file as well as the JAR file.

What to do next

Refresh the web browser to see the changes in TIBCO BusinessEvents WebStudio. If you don't see the
changes, perform a browser cache cleanup (as sometimes the values are loaded from the cache) and
reload the URL.
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